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Getting Started

System Requirements
In order to use the Eudora electronic mail (E-mail) program (hereafter referred to as
Eudora), the following system requirements must be satisfied:

• Macintosh System 7 or later.

• Ethernet card or a DDP/IP gateway or modem.

• At least 340K of free RAM.

• Account on a computer with a Post Office Protocol version 3 (POP3) server.

Installing Eudora
To install Eudora on your Macintosh, copy the program icon from the diskette to your
hard drive.

Eudora Configuration
After you have installed Eudora, double-click on its icon to open the program.  Before
you can actually use Eudora, you must give it some necessary pieces of information.  To
enter this information, select Settings... from the Special menu.  The Settings dialog is
then displayed with the Getting Started settings selected.

Settings dialog

To use Eudora, you must have an account on a computer that runs a POP server.  This is
the account to which your e-mail messages are delivered before they are transferred to the

QUALCOMM Incorporated 11



Getting Started Eudora User Manual

Eudora program on your Macintosh.  In the POP Account field, type your login name for
this account and the full (domain) name of the computer, separating them with an “@”
sign.  For example, if your assigned login name is “carolyn,” and the name of the
computer where you receive e-mail is “uxh.cso.uiuc.edu,” type
“carolyn@uxh.cso.uiuc.edu” in this field.

In the Real Name field, type your real name.  Your name, as it appears here, is displayed
in parentheses after your return address in your outgoing mail.  It is also displayed in the
sender column of all messages sent by you.

If you are using Eudora with a network connection, select MacTCP as the Connection
Method.  If you are using a modem or other serial connection,  select Communications
Toolbox as the Connection Method.  Then, select the Communications... dialog from the
Special menu and choose the appropriate modem/serial communications settings.

You are now ready to use Eudora.  For a quick introduction to the program’s basic
functions, see the Tutorial chapter of this document; for detailed explanations of all
available Eudora functions, see the Reference chapter.
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Tutorial

Introduction
This tutorial is designed to be an introduction to Eudora’s basic functions.  There are a
host of other operations that are not described here.  For detailed explanations of all
available Eudora functions, see the “Reference” chapter of this document.

Balloon Help
Eudora has extensive Balloon Help.  From the Balloon Help menu, select Show
Balloons to turn this function on.  Move the mouse pointer to a Eudora menu selection or
item on the screen to display a brief description of that item (see the example below).
When you no longer require assistance, select Hide Balloons to turn Balloon Help off.

Note: If you have an extended keyboard with a [help] key, it can be used to turn
Balloon Help on and off.

Help balloon example

It’s possible to turn balloon help on even when a dialog is displayed. If you’re not sure
how to respond to a dialog, try balloon help.

Creating an Outgoing Message
A good way to familiarize yourself with Eudora is to create an outgoing message.  An
outgoing message is one that you send to someone else.

From the Message menu, select New Message.  A new composition window is displayed
with the blinking cursor situated at the start of the To: field.
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Composition window

Notice the icon bar of symbols and check marks between the title of the window and the
To: field.  You may ignore the icon bar for now; it is explained in the “Reference”
chapter.

Since it is easiest to experiment with Eudora by sending a message to yourself, type your
own E-mail address in the To: field.

Note that the From: field has been automatically filled in (and can’t be altered).   This is
the message’s return address; it should be your own Post Office Protocol (POP) server
account address.

Press the [tab] key or point and click the mouse to move the cursor down to the Subject:
field.  Typically, this field should contain some brief text indicating what the message is
about.  For this message, type the words Test Message.

Move the cursor past the remaining Cc:, Bcc:, and Attachments: fields down into the
large area below them.  This area is reserved for the actual body of the message.  Here
you may type in whatever text you want.  When you finish composing your message (to
be referred to throughout this tutorial as your test message) the composition window
should look something like the example below.

Example test message, ready to send
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Sending a Message
Notice the Send button in the upper right hand corner of the composition window.  To
send a message in its current state, simply click on this button.  Click it now.

Clicking the Send button

The composition window immediately closes, and the progress window is momentarily
displayed the top of the screen.  Eudora uses the progress window to report on the
progress of lengthy operations.  In this case, it indicates that the message is being
transferred out onto the network.

Progress window

Checking for and Receiving Mail
There are two ways to check your POP server to see if you have any new mail.  One way
is automatic and is determined by the Check for mail every ? minutes setting in the
Settings dialog (Checking Mail).  The alternative is to check for mail manually whenever
you want by selecting Check Mail from the File menu.  Do this manual check now.

Each time the Eudora program is opened, your password is requested prior to the first
mail check, whether it is conducted automatically or manually. Upon the first check, such
as now, a dialog is displayed requesting the password of your POP account.

Password dialog

Type in the password and click OK.  If you make a mistake before clicking OK, simply
backspace and re-enter the password correctly.  If your password is rejected, repeat the
manual check by selecting Check Mail from the File menu and re-entering your
password.

Note: Remember that the Eudora password is case-sensitive, so it must be typed
in exactly or it is rejected.
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After successfully entering your password, a progress window is momentarily displayed
at the top of the screen indicating that an attempt to reach your POP account is being
made.

Progress window

If there is a network problem between you and the POP server, an alert is displayed (see
below).

Problem transferring mail

Note: Should you ever have a problem of this type, the numbers in {}’s are very
important.  Record these numbers for reference when reporting the
problem.

If there is no mail waiting at your account on the POP server, the You have no new mail
alert is displayed.  This means that the message you sent yourself in the previous exercise
has not been delivered to your POP account yet.  Click OK.

No new mail alert

Keep selecting Check Mail from the File menu until your test message arrives.

When mail is found waiting in your POP account, the progress window remains at the top
of your screen, allowing you to monitor the transfer of messages from the POP server to
your Macintosh.  This is followed by an alert stating that you have new mail.
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New mail alert

Click OK.  Then, select In From the Mailbox menu to open the In mailbox.  The In
mailbox window is displayed with your test message summary listed inside.

Message listed in In mailbox

Messages are listed in mailbox windows as individual message summaries.  A message
summary is divided into fields containing the status and priority of the message (these are
discussed in the “Reference” chapter), the name or address of the sender, the time and
date the message was sent, its size in K, and the contents of its Subject: field.

To select (highlight) the message summary, single-click anywhere on the summary.  To
open the message, double-click on its summary.  Do this for your arrived test message to
display it on your screen.

Test message display

Incoming messages are stored indefinitely in the In mailbox until they are deleted or
transferred to another mailbox (as described later in this tutorial).

To close the message, either click the close box in the upper left-hand corner of the
message window or select Close from the File menu.  The In mailbox can also be closed
in the same fashion.
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Current Messages
Eudora has been designed so that most commands can be applied either to an open
message window or to highlighted message summaries in a mailbox window.  This
allows Eudora users to apply commands (such as Transfer, Forward, and Reply) to
messages without opening them first.  Whenever the term current message is used in this
tutorial or in the “Reference” chapter, it refers to a message that is open and is in the
topmost window or whose message summary is highlighted within a mailbox window
(see the following examples).

When a message window is frontmost, it is
the current message.

A selected message summary is current.

Multiple selected message summarries are current.

Examples of current messages
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Replying To a Message
For any current incoming message (an incoming message is one that someone has sent to
you), you may easily initiate a reply message to its sender without having to create a new
message from scratch.

Open the In mailbox by selecting In from the Mailbox menu.  Single-click on the
message summary of your test message to highlight it.  From the Message menu, select
Reply to initiate a reply to this message.

Note: Select Reply, not Reply To; the Reply To menu item is for use with the
quick recipients list, which is described in the “Reference” chapter.

A new composition window is displayed, with the sender’s address (in this case, your
own) automatically placed in the To: field of the header.  The original sender’s text is
automatically included in the body of the message (prefixed by “>”  at the beginning of
each line).  This text may be edited as needed.  Since it is fully selected in the new
composition window, it can be easily deleted by pressing [delete].  You may enter more
text in the reply message just as in any outgoing message.  At this time, move the
insertion point to the area below the original message and type in some additional text.

Replying to a message

Do not send the reply message at this time.  Instead, save it as described in the “Saving an
Outgoing Message” section.

Saving an Outgoing Message
Sometimes it is convenient to save an outgoing message either as a safeguard when
typing long messages, or for temporary storage so you can return to it at a later time for
changes or additions prior to sending it.

To save any current outgoing message, such as your new reply message, select Save from
the File menu.  This doesn’t close the composition window but it does save the version of
the message (as it appears at the time of the save) in the Out mailbox, which holds all
outgoing mail.

As long as an outgoing message has not yet been sent out on the network, changes can be
made to it.  For example, if you had wanted to also send the message to another person,
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you could add his/her address to the To: field  (any two addresses in a single field must
be separated by a comma).  Having saved your reply message, close the reply message
window.  Open the Out mailbox (from the Mailbox menu, select Out) and verify that
your reply message is stored there.

Transferring a Message Between Mailboxes
Eudora helps you to better organize your incoming mail by allowing you to create new
mailboxes and easily transfer messages between them.

First, create a new mailbox while simultaneously transferring your test message into it.
From the Mailbox menu, select In to open the In mailbox.  Single-click on your test
message summary to highlight it (making it the current message).  Then, select New...
from the Transfer menu.  The New mailbox dialog is displayed.

New mailbox dialog

Any name can be typed in here, but for this example, type Testing.  Click OK to create
the new mailbox.  Because your test message was highlighted when you selected New...
from the Transfer menu, it is automatically transferred into the Testing mailbox.  To
verify this, select Testing from the Mailbox menu.

Current messages can also be transferred between existing mailboxes.  To demonstrate
this, move your original test message from the Testing mailbox back into your In
mailbox.  Highlight the test message summary (click on it once in the Testing mailbox
window) and then select In from the Transfer menu.
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Message Transfer

After Transfer

Transferring a message

Deleting a Message
Messages are stored indefinitely in any mailbox until they are explicitly deleted or
transferred to another mailbox.  Outgoing messages that have been saved for further
changes remain in the Out mailbox until they are either sent or deleted.  Any current
message can be deleted.

Open your test message from the In mailbox.  Then, select Delete  from the Message
menu.  Next, open the Out mailbox and select (without opening) the message summary of
the reply message you generated previously.  Again, select Delete from the Message
menu to remove the message from the Out mailbox.

As a safeguard, the Delete command doesn’t actually delete messages but transfers them
to the Trash mailbox.  So, if you suddenly realize you mistakenly deleted a message, it
can be recovered from and transferred out of the Trash mailbox.

All messages stored in the Trash mailbox are automatically deleted when you quit
Eudora.  To manually delete messages held in the Trash mailbox, select Empty Trash
from the Special menu.
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Introduction
This chapter provides detailed explanations of all available Eudora functions.

Creating an Outgoing Message
An outgoing message is a message you send to someone else.

To create an outgoing message, select New Message from the Message menu.  A new
composition window entitled <<No Recipient>>, <<No Subject>>  is displayed with the
blinking insertion point situated at the start of the To: field.  The composition window
consists of the title bar, the icon bar, the message header, and the message body.

Icon Bar

Tit le Bar

 Message
Header

Message
Body

The composition window

Title Bar
The title bar provides information about incoming and outgoing messages, including the
name of the sender (if it is an incoming message) or addressee (if it is an outgoing
message), the time and date the message was delivered or sent, and the message subject.
New messages are labeled <<No Recipient>>, <<No Subject>> until they are sent or
queued.  Messages get time stamps when they are sent, or if they are queued for timed
delivery.

Icon Bar
The icon bar consists of a series of objects that are displayed just under the composition
window title.  It allows you to control your message’s priority, override some of your
preference settings for that message only, and send or queue the message.  There is one
popup menu and five icons.  Each of the five icons may be turned on or off for the current
message by clicking on it.  A check mark symbol appearing next to the icon denotes that
the icon has been turned on.  The popup menu and icons are described below.
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The Icon Bar

Note: The default settings for the icon bar are determined in the Settings dialog
(see the “Settings Dialog” section).

Priority/Attachment Type Popup
The leftmost object in the icon bar is the Priority/Attachment Type popup menu.

Priority/Attachment Type popup menu

The Priority portion of this popup menu is on top.  If you want to indicate that
your message is of a higher or lower priority than a normal message (blank), use
this menu to make the desired selection.  Priorities are discussed in the “Message
Priorities” section.

The Attachment Type portion of this menu allows you to select what format
documents that you attach to outgoing messages are encoded in:  AppleDouble,
AppleSingle, or Bin Hex.  AppleDouble is best for recipients with Multipurpose
Internet Mail Extensions (MIME); AppleSingle is best for sending applications
or other Macintosh-specific files; and Bin Hex is most compatible with old
Macintosh mailers and previous versions of Eudora.

The Always As Documents option should be selected when sending attachments
between Macintoshes, as this keeps the attachments in their original Macintosh
format.  However, when sending a document to another platform, de-selecting
this option allows Eudora to convert the attachment into the format most likely
to be understood by other platforms.

Signature
If this icon is checked, your signature file is automatically attached to the end of
each message you send.  Signatures are discussed in the “Creating a Signature”
section.

Word Wrap
If this icon is checked, a carriage return is not required at the end of each line
you type in an outgoing message; Eudora automatically wraps text to the next
line, with line breaks at roughly 76 characters per line.
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Tabs in Body
If this icon is checked, hitting the [tab] key within the message body results in
Eudora inserting enough spaces to move the insertion point to a multiple of 8
characters from the start of the line.  This mimics the way tabs work on many
terminals. If this icon is not checked, hitting the [tab] key returns the cursor to
the To: field of the message header.

Note: This icon also controls the handling of tabs in text that is pasted
into the message window and in plain text attachments that are
sent as documents (not binhexed).  If Tabs in Body is checked,
tab spacing is replaced by blank spaces; otherwise, the tabs are
included in the text.

Keep Copy
If this icon is checked, a copy of each sent message is kept in the Out mailbox
(their summaries are marked with an “S” in the far left column of the Out
mailbox window, indicating that they have been sent).  These messages are
saved until they are deleted or transferred to a different folder.

Quoted-Printable Encoding
If this icon is checked, quoted-printable encoding may be used when sending
messages that contain long lines of text or special characters.  When selected, it
is used for all plain text attachments.  It is recommended that this icon always be
checked.

Send or Queue
If the Immediate Send option in the Settings dialog (Sending Mail) is turned on,
the rightmost button in the icon bar is labeled Send.  Clicking the Send button
immediately sends the message.  Otherwise, this button is labeled Queue, and
has the same function as the Queue for Delivery command under the Message
menu (upon clicking this button, the message window closes and the message is
held in the Out mailbox, marked ready for delivery).

Message Header
Outgoing message headers consist of six fields:  To:, From:, Subject:, Cc:, Bcc:, and
Attachments:.  Each field holds a different piece of information.  The To:, Subject:, Cc:,
and Bcc: fields can be directly edited.

To move the insertion point from field to field, press the [tab] key or click in the desired
field with the mouse.  When entering information into the fields, use the standard
Macintosh text-editing tools provided under the Edit menu.  Here is a brief description of
the intended contents of each field:

To:
The intended recipient’s E-mail address, or a nickname you have defined (see the
“Creating and Using Nicknames” section).  Multiple addresses are allowed, but must be
separated by commas.

From:
The sender’s E-mail address.  This is usually your POP account plus your real name.
You can use a return address other than your POP account by entering the desired address
in the Return Address field of the Settings dialog (Personal Information).

Subject:
Brief text indicating the contents of the message.  This field can be left blank (though it is
a breach of E-mail etiquette to do so).
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Cc:
E-mail address or nickname of person to whom a copy of the message is to be sent.
Multiple addresses are allowed but must be separated by commas.  This field may be left
blank.

Bcc:
“Blind” carbon copy.  Like addresses listed in the Cc: field, addresses listed here receive
copies of the message.  Unlike addresses listed in the Cc: field, addresses listed here do
not appear in the message header of the recipients.  This is useful when you want to send
a copy of a message to someone without everyone else knowing you did so.  Multiple
addresses are allowed but must be separated by commas.  This field can be left blank.

Attachments:
List of documents being sent along with the message.  Specify these through the Attach
Document command under the Message menu (see the “Attachments” section).  To delete
an attachment from a message, select it and press [delete].  You cannot enter information
directly into this field.  This field can be left blank.

Message Body
After filling in the fields, move the insertion point to the space below the message header.
Type the body of the message here.  Feel free to use the standard Macintosh text-editing
tools provided under the Edit menu (see the “Summary of Menu Commands” section).

If the Word Wrap icon on the icon bar is checked (or the Word wrap option in the
Settings dialog [Sending Mail] is turned on), you don’t need to press [return] at the end of
each line of text.  The text wraps to the next line automatically.  If this option is not set,
be sure to type a [return] at the end of each line or your message may not be legible on
the recipient’s computer.  To use tabs in the message body, check the Tabs in Body icon
in the icon bar.

Saving an Outgoing Message for Later Changes
Sometimes it is convenient to save an outgoing message either as a safeguard when
typing long messages, or so you can return to it later to edit or add more text.

To save the message while the outgoing message window is open, select Save from the
File menu.  The message window does not close, but the current version of the message
is saved in the Out mailbox.  You might notice that the title appearing at the top of the
message window changes from <<No Recipient>> << No Subject>> to what you typed in
the To: and Subject: fields of the message.

If you now close the message (by clicking the close box in the upper left-hand corner of
the message window, or by selecting Close from the File menu), it can be re-opened from
the Out mailbox for further changes.  As with any message summary listed in a mailbox
window, it can be identified by the contents of its To: and Subject: field. A small black
dot, or bullet, to the left of a message summary listed in the Out mailbox indicates that
the message is being indefinitely held there and is queueable.  Such messages remain in
the Out mailbox until they are queued and sent or deleted.
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A sendable message saved in the Out mailbox

If you try to close an outgoing message window without specifically saving that version
of the message, an alert is displayed asking if the message should be saved or the changes
discarded.  If you select Discard and the message has never been saved, the message is
deleted.

Closing an unsaved composition window

Sending A Message
One-Step Send
If the Immediate Send option in the Settings dialog (Sending Mail) is turned on, select
Queue for Delivery from the Message menu to immediately send a current message.
Alternatively, the rightmost button appearing in the icon bar at the top of the current
message window is labeled Send.  Click this button to send the current message.

Clicking the Send button

A progress window is displayed momentarily at the top of the screen indicating the
progress of the transmission.
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Progress Window

Two-Step Send
Some people may prefer to compose many messages and transmit them all at once.  This
is only possible if the Immediate Send option in the Settings dialog (Sending Mail) is
turned off.

To accomplish the first step for any outgoing current message,  select Queue For
Delivery from the Message menu.   Alternatively, the rightmost button appearing in the
icon bar at the top of the current message window is labeled Queue.  Click this button to
queue the current message for later delivery.

Clicking the Queue button

Either of these selections closes the message window (if it was open), saves the message
in the Out mailbox and marks it as queued, meaning ready to be delivered.  Queued
messages are marked by a “Q” in the far left-hand column of the Out mailbox.

A Queued message in the Out mailbox

For the second step, select Send Queued Messages from the File menu.    This sends the
queued message (or messages).  A progress window is displayed momentarily at the top
of the screen indicating the progress of the transmission.

Timed Messages
It is possible to tell Eudora to send a message at some specific time in the future.  To do
this for the current outgoing message, select Change Queueing... from the Message
menu.  The Change Queueing... dialog is then displayed.
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Change Queueing dialog

If you choose Right Now, the message is sent immediately upon clicking the OK button.
If you choose Next time queued messages are sent, the message is sent the next time
queued messages are sent.  If you choose On or After, you can use the time and date
fields to fill in the time when the message should be sent.  The message is saved in the
Out mailbox with a Q in the status column, just as if it were a normal queued message.
However, the message is not actually sent until the specified time arrives.

Note: For the message to be sent at the correct time, Eudora must be running
when the message is due to be sent.  If Eudora is not running, the message
is sent the first time Eudora is run after the selected time has passed.

Sending Queued Messages on Check
If the Send on Check option in the Settings dialog (Sending Mail) is turned on, every time
a manual or automatic mail check occurs, all queued messages are sent, thus saving you
the step of selecting Send Queued Messages.

Quitting with Queued Messages
If you quit Eudora after you have queued messages, but without sending them using Send
Queued Messages, Eudora gives you the opportunity to send the messages before you
quit.

Quitting with queued messages

If you quit with timed messages, and the messages are due to be sent within the next 12
hours, Eudora warns you and gives you the opportunity to send them.
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Quitting with timed messages

Editing a queued message
To edit a queued message, open the Out mailbox and double-click on the desired message
summary to open its composition window.  Make the necessary edits and re-queue the
new version of the message with the Queue For Delivery or Change Queuing...
commands from the Message menu or the Save command from the File menu.  You may
also re-queue the message using the Queue button on the icon bar.  The message is
returned to the Out mailbox with a queued status.  If you close the changed message
without choosing one of these, an alert is displayed asking you to verify the changes.

Changing the Status of a Queued Message
A message that is queued but as yet unsent may be unqueued using the Change
Queuing... command.  Open the Out mailbox and select the desired message summary.
Then, select Change Queueing... from the Message menu and click on Don’t Send.
This changes the message status from queued (Q) to saved (S).  The message is held in
the Out mailbox until it is either deleted or re-queued and sent.

Note: You can also send a message immediately or change it to timed send using
the Change Queuing... command.

Keeping Copies of Outgoing Messages
Once a message is sent, it is put into the Trash mailbox unless the Keep Copies of
Outgoing Mail option in the Settings dialog (Sending Mail) is turned on or the Keep
Copy icon in the icon bar is checked.  In these cases,  the message is left in the Out
mailbox and is annotated with an S in the status column of the Out mailbox indicating
that the message has been sent.

Copies of outgoing messages saved in the Out mailbox

Password Protection
There is password protection on mail checks to your account on the POP server.  Each
time the Eudora program is opened, your password is requested prior to the first mail
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check, whether it is conducted automatically or manually.  If automatic checking is set
(see the “Settings Dialog” section), a dialog requesting your POP server account
password is displayed upon first opening Eudora.  If automatic checking is disabled, the
same dialog is displayed at the time of your first mail check.

Password dialog

Type in your password and click OK.  If you make a mistake before clicking OK, simply
backspace and re-enter the password correctly.

If your password is rejected, an error message is displayed indicating that you have
entered the wrong password (see below).  Select Check Mail from the File menu to
redisplay the password dialog.

Wrong password

Note: Remember that the Eudora password is "case-sensitive," so it must be
typed in exactly or it is rejected.

As long as it is running, Eudora remembers your password.  If you don’t want it to
remember (when, for example, you are away from your Macintosh), choose Forget
Password from the Special menu.  At your next mail check you are prompted for your
password again.

Another password-related option is Save Password, which is in the Settings dialog
(Checking Mail).  This option makes Eudora remember your password from one session
to the next (you NEVER have to enter your password again, even if you quit and restart
Eudora).  This option should only be used if your machine is in a secure location.

Finally, the Change Password... command in the Special menu can be used to change
your POP server password if your POP server machine is running a compatible password-
change server.  You’ll be asked to enter your old password once, and your new password
twice.
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Changing a password with Eudora

Note: For information on password-change servers, see Appendix A of this
manual.

Checking For and Receiving Mail
The POP server is the machine where your mail is received and stored until it is
transferred to the Eudora program on your Macintosh system.  Your POP server account
is specified in the POP Account setting in the Settings dialog (see the “Settings Dialog”
section).

Note: To best understand the functioning of the POP server with respect to
Eudora, please see Appendix C.

There are two methods to check your designated POP server to see if you have new mail.
One method is automatic and the other is manual.  Both methods deliver any mail
addressed to you from the POP server to your Macintosh.  Before any checks are made,
however, the POP server requests your account password.

Automatic Checking
Eudora automatically checks for mail if you tell it how often to do so.  From the Special
menu, select Settings....  Then, select the Checking Mail settings.  In the Check for mail
every ? minutes field, type in a value and Eudora automatically checks for mail at the
desired interval whenever it is running (even if you are using other applications on your
Macintosh).  For example, if you type in 15, Eudora checks for mail every 15 minutes.  In
fact, 15 minutes is a good minimum interval, as checking mail more frequently puts an
unnecessary load on your POP server.

Note: If automatic checking is set, the Check Mail command under the File menu
displays the next time that an automatic check is scheduled to occur.

When Eudora does a mail check, you can be notified of new mail in one or all of four
different ways: an alert dialog, a special sound, a flashing mail flag icon in the menu bar,
or the opening of the In mailbox.  These options are turned on or off in the Settings dialog
(Getting Attention).

When you receive notice that new mail has arrived, select Eudora from the applications
menu.  Mail always arrives in the In mailbox.  The messages are listed in the order they
are received, with the most recent message listed last.
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Unread messages in the In mailbox

If the In mailbox is not already open, select In from the Mailbox menu.  Unread
messages are designated by a small black dot, or bullet, on the left side of the message
summary.  Double-click anywhere on a message summary to open the message.
Incoming messages are saved indefinitely in the In mailbox until they are deleted or
transferred to another mailbox.

Manual Checking
You may check for mail manually at any time by selecting Check Mail from the File
menu.  If you haven’t successfully entered your password since opening the Eudora
program, you are prompted for it.

The Progress window is displayed momentarily at the top of the screen as the POP server
is checked.

The Progress window during a mail check

If there is no mail waiting at your account on the POP server, the You have no new mail
alert is displayed.  Click OK.  You may check for mail again later.

No new mail dialog

If there is a problem reaching the POP server, an error message alert is displayed.  To
rectify the problem, review the POP server settings in the Settings dialog for correctness.
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Error while checking mail

If there is new mail, it is transferred automatically from the POP server to Eudora on your
Macintosh system.  A progress window is displayed at the top of your screen allowing
you to monitor the mail transfer.  If the Use an Alert option in the Settings dialog
(Getting Attention) is turned on, the new mail dialog is displayed, stating that new
messages have been delivered.

New mail dialog

If the Open mailbox (new mail only) option in the Settings Dialog (Getting Attention) is
on, the In mailbox window also displays.  Unread messages in the In mailbox are
designated by a small black dot, or bullet, on the left side of the message summary.
Double-click anywhere on a message summary to open the message.  Incoming messages
are saved indefinitely in the In mailbox until they are deleted or transferred to another
mailbox.

Leave Mail on Server Option
During a mail check, Eudora normally transfers your incoming messages from your
account on the POP server to your Macintosh, and deletes them from the POP server.
This may prove awkward for people who sometimes want to read mail from a secondary
Macintosh system.  It results in non-consolidated storage of messages – if you read mail
through a secondary Macintosh, you wouldn’t be able to act on that mail from your
primary Macintosh.

The Leave Mail on Server option in the Settings dialog (Checking Mail) solves this
dilemma.  If this option is turned on, Eudora transfers all of your new messages from the
POP server to the Macintosh you are presently using (presumably a secondary
Macintosh), while keeping copies of those messages in your account on the POP server.
On the next mail check from the secondary Macintosh, Eudora ignores the copies of
previously read messages and looks for new ones.
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When using your primary Macintosh system, you should turn the Leave Mail on Server
option off, so that all messages (new ones as well as copies of old ones you read through
other Mac systems) are transferred to and consolidated on the one primary system.  The
Leave Mail on Server option should be used with care, since it can result in a buildup of
messages on the POP server machine.

Note: Eudora looks for a Status: R header to determine if a message has been
read.  Your POP server must cooperate for this to work; most do.

Skip Big Messages Option
If the Skip Big Messages option in the Settings dialog (Checking Mail) is turned on,
Eudora does not download large messages (40K or larger).  Instead, it downloads only
the first few lines of such messages and adds a note at the bottom stating that the whole
message has not been transferred.  This can be useful on slow connections.

Note: Eudora requires some help from your POP server to make Skip Big
Messages work properly.  Specifically, Eudora expects your server to add
a Status: header once Eudora has downloaded the first few lines of the
message.  Eudora uses that line as a signal that it already has the first few
lines and doesn’t need to download them again.

Stopping a Mail Check
If you want to stop a mail check in the middle (because it is taking longer than
anticipated), hold down the [command] key and type a period [.].

Opening a Mailbox to Read a Message
To open a mailbox, select the desired mailbox from the list of mailboxes under the
Mailbox menu.  The mailbox window is then displayed.

Opening a mailbox window

To open a “nested” mailbox (one that is contained within a mail folder), select the
outermost folder from the Mailbox menu (folders are designated by an arrow next to their
names).  This displays the sub-menu of mailboxes and/or folders within the outer folder.
Select the desired mailbox (or continue selecting sub-folders until the mailbox can be
selected).

QUALCOMM Incorporated 35



Reference Eudora User Manual

Opening a mailbox in a mail folder

If any messages are stored in the mailbox, they are listed as individual message
summaries.  A message summary usually consists of the message status and priority, the
sender/recipient of the message, the date it was received, its size and the subject heading.
See the “Anatomy of a Mailbox Window” section for descriptions of these fields.

Message summaries listed in the In mailbox

To open a message, double-click on its message summary, or, if the message summary is
current (highlighted), select Open... from the File menu or press the [return] key.

Incoming message window example

The incoming message window consists of the title bar, the icon bar, and the message
body.  If the BLAH,BLAH,BLAH icon in the icon bar is checked, all of the message
headers are displayed.

Note: These message headers may be useful when tracking down a network
problem.
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Incoming message with all headers displayed

Creating Mailboxes and Mail Folders
There are two ways to create new mailboxes and mail folders.  You can create mailboxes
and folders using the Mailboxes dialog under the Special menu (see the “Mailboxes
Window” section), and you can create mailboxes and folders using the New... option
under the Transfer menu (see the “Creating a Mailbox During Transfer” section).  The
Mailboxes window is most useful if you want to create several mailboxes at one time.
The New... option is most useful if you want to create a mailbox and simultaneously
transfer a message or messages into that mailbox.

Anatomy of a Mailbox Window
Mailbox windows are one of the most important elements of Eudora.

A mailbox window

Message Summaries
Each line in a mailbox window represents one message and is called a message summary.
To select a message summary, single-click on it.  There are several ways to select more
than one summary.  You can select a summary and drag through the ones you want to
select.  You can select one summary, hold down the shift key, and select another
summary to select both summaries and all the summaries between them.  Finally, you can
hold down the [command] key and select individual summaries.  This allows you to make
“disjoint” selections.
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A disjoint selection in a mailbox window

Mailbox Window Columns
A mailbox window (and hence each message summary) is divided into five columns:
Status/Priority, Sender/Recipient, Date, Size, and Subject.

The Status/Priority column displays two separate items.  The first is the message status,
which is one of the following:

• The message has not been read (all mailboxes except Out), or is
queueable but has not been queued (Out mailbox only).

<blank> The message has been read (all mailboxes except Out), or is not yet able
to be queued because it has no recipients (Out mailbox only).

R Reply has been chosen for the message.
F Forward has been chosen for the message.
D Redirect has been chosen for the message.
S The message has been sent (outgoing messages only).
- The message was transferred from the Out mailbox before being sent.

The message priority is displayed as follows:

Highest priority

High priority
(blank)
Normal

Low priority

Lowest priority

For more information on message priorities, see the “Message Priorities” section.

The Sender/Recipient column shows the sender of the message (for incoming messages)
or the recipient or intended recipient (for outgoing messages).

Note: Bugs in some POP servers/mail transport systems may result in Eudora
displaying the sender of incoming messages as ???@???.  This is because
the required From: header is missing.

The Date column displays the date and time the message was sent, or, for timed
messages, the date and time the message is scheduled to be sent.

Note: The date is formatted according to the short date format in current use by
your Macintosh, and the time is formatted according to the current time
format.

The Size column displays the size of the message, in K (K = 1024 bytes).
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The Subject column displays the subject of the message.  This information was typed into
the message header by the sender.

Resizing Columns
You can resize any column in a mailbox window.  Move the mouse pointer until it is over
the dotted column divider to the right of the column you want to resize.  The pointer turns
into the column resize cursor.

Column resize cursor

Simply press the mouse button, drag the divider to the position you desire, and release the
mouse button.  The column divider moves to the new location, and the mailbox is
redrawn.

Mailbox after resizing column

You can only shrink a column as far as its left divider.  If you do so, a double divider line
is displayed in place of the column, and its contents are hidden.  To redisplay the column,
drag the right divider line to the right.

Mailbox window with a hidden column

Mailbox Size Display
The lower left corner of each mailbox window displays size information for that mailbox.
Three numbers are displayed.  The first is the number of messages in the mailbox; the
second is the total amount of space those messages require; and the third is the amount of
disk space that is wasted in the mailbox.  Eudora occasionally recovers this wasted space
on its own.  To force Eudora to recover this space from all mailboxes, select Compact
Mailboxes from the Special menu.  To compact an individual mailbox, hold down the
[command] key and single-click on the mailbox size display.
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This mailbox contains 43 messages, which take 50K of disk space – 21K of which is wasted

Deleting a Message
As a safeguard against inadvertent deletions, two steps are required to delete a message in
Eudora.  For any current message, choose Delete from the Message menu.  This does not
actually delete the message, but transfers it to the Trash mailbox.  To delete messages
from the Trash mailbox, select Empty Trash from the Special menu.  Quitting the
program also empties the contents of the Trash mailbox when the Empty Trash on Quit
option in the Settings dialog (Miscellaneous) is turned on.  Finally, if you want to delete
just a few messages from the Trash mailbox, highlight them and select Delete from the
Message menu.  Deleting a message that’s already in the Trash removes it from Eudora
completely.

Note: If the Requireconformation for delete option in the Settings dialog
(Miscellaneous) is turned on, any attempt to delete a message that you
have never opened (or a Queued message that hasn’t been sent) results in
Eudora asking for confirmation before proceeding with the deletion.

Compacting Mailboxes: Recovering Storage Space
Even after a message has been deleted with the two-step process described above, the
storage space which that message originally required is still taken.  Normally, Eudora
recovers this space automatically when it becomes troublesome.  However, if disk space
is very tight, you can force this to happen earlier than usual.  In order to reclaim the
storage space, select the Compact Mailboxes from the Special menu.  To compact an
individual mailbox, hold down the [command] key and single-click on the mailbox size
display (see the “Mailbox Size Display” section).

Note: Eudora compacts mailboxes automatically when you close them under
either of two conditions.  Mailboxes are compacted if the amount of
wasted space in the mailbox is greater than the amount of space the
messages in the mailbox use, or if the amount of space wasted in the
mailbox is greater than 5% of the free space on the volume that contains
it.

Transferring a Message to a Different Mailbox
Messages may be transferred between any two mailboxes.  For any current message,
select the mailbox to which the message should be transferred from the Transfer menu.
The message is removed from its previous location and stored in the selected mailbox.
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Transferring a message

If you hold down the [option] key while transferring a message, the message is copied
into the new mailbox instead of transferred.  This is useful if you want to file a message
in more than one mailbox.

Creating a Mailbox During Transfer
To create a mailbox and transfer the current message into it at the same time, select
New... from the Transfer menu instead of the name of a mailbox.  The New mailbox
dialog is displayed.

New mailbox dialog

Type in the new mailbox name and click OK.  The mailbox is created and added to the
Mailbox and Transfer menus.  The current message is also transferred into the new
mailbox.  However, if you check the Don’t transfer, just create mailbox option, the
mailbox is created but the message isn’t transferred into it.
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You can also create mailboxes using the Mailboxes dialog under the Windows menu (see
the “Mailboxes Window” section).  The Mailboxes window is most useful if you want to
create several mailboxes at one time.

Creating a Mailbox Folder During Transfer
Eudora allows you to create mail folders in which you may keep one or more mailboxes
and even other sub-folders that hold additional mailboxes.  In other words, not only can
mailboxes be organized into folders, but folders can be contained one within another.

To create a new mail folder during message transfer, select New... from the Transfer
menu instead of the name of a mailbox.  The new mailbox dialog is displayed.  Type the
name of the new mail folder and check the Make it a Folder option.  Click OK to create
the folder.

Creating a mail folder

The new folder name is displayed at the bottom of the list of mailbox names under the
Mailbox and Transfer menus.  There is an arrow next to the name designating it as a
folder and not as a mailbox.  Your message can’t be transferred, however, since messages
must be in mailboxes and you have not yet created a mailbox.  Therefore, the new
mailbox dialog is displayed again.  Now, type the name of the mailbox you want to create
within the newly-created folder and click OK to complete the transfer.

Mailboxes Window
Mailboxes and mail folders provide a structured way for Eudora users to organize
received messages.  The Mailboxes window allows you to create new mailboxes and
folders and to remove and rename them.  You may also want to move mailboxes and
folders from one folder to another one.

To accomplish any of these tasks, choose Mailboxes from the Special menu.  The
Mailboxes window is displayed.
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The Mailboxes window

The window has two identical listings with scroll bars, each entitled Eudora Folder (or
whatever the name of the folder holding your mail is – see the “Mail Storage” section).
These list the names of the mailboxes and folders you have created (folders are identified
by an arrow to the right of the name).  This list is similar to that displayed under the
Mailbox and Transfer menus, except that the In, Out, and Trash mailboxes aren’t
included.  Underneath each of the lists are buttons labeled Rename, New, and Remove.
Between the lists are two additional buttons labeled Move, each pointing from one list to
the other.

Double-clicking on any of the mailboxes in a list opens that mailbox window on the
screen.  Individual messages can be selected, opened, and otherwise manipulated from
there.

Finding the Mailbox or Folder
If the Mailbox window isn’t big enough to display all of your created mailboxes and
folders, use the scroll bar on the right side of either list to view the rest of the mailboxes
and folders.

Double-clicking on a folder (denoted with an arrow to the right of its name) changes the
current title of the list from Eudora Folder to that of the chosen folder.  The contents of
the list also change to the names of mailboxes and sub-folders contained in the chosen
folder.
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Opening a mail folder

To move back out of the sub-folder to the folder that contains it, select the inner folder’s
title above the listing of its contents.  A popup menu is displayed listing the available
folders.  Choose one of the folder names in this popup menu to change the list to reflect
that folder’s name and contents.

Moving back out of a mail folder

Removing a Mailbox or Folder
With the Mailboxes window open, use the scroll bar and selection tool to locate the name
of the mailbox or folder that you want to remove.

Note: You can perform this function using either of the two lists in the Mailboxes
window.  It is not necessary to locate a mailbox or folder in both lists
before deleting it.
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Once the desired mailbox/folder is found, click on it once to select it.  Then, click on the
Remove button that is located below the list.

Starting to remove a mailbox

A dialog is then displayed asking you to confirm the mailbox removal.  Click on the
Remove It button to remove the mailbox.

Mailbox removal dialog

If you press the [command] key while selecting from a list of mailboxes/folders, you can
select more than one mailbox or folder simultaneously.  When you click on the Remove
button, the mailbox removal dialog is displayed to verify the removal.  The dialog
contains the name of the first mailbox you have selected.  If you click on Remove It,
Eudora removes that mailbox, and then displays another dialog for the next mailbox.  If
you click on Remove All, all of the selected items are removed without any further
prompts.

If you choose to remove a mailbox in which messages are still stored, or a folder in which
other mailboxes or folders are stored, all messages/mailboxes/folders contained within
the selected mailbox are also removed.

Removing a mailbox with messages in it
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Renaming a Mailbox or Folder
With the Mailboxes window open, use the scroll bar and mouse pointer to locate the
name of the mailbox/folder that you want to rename.

Note: You can perform this function using either of the two lists in the Mailboxes
window.  It is not necessary to locate a mailbox or folder in both lists
before renaming it.

Once the desired mailbox/folder is found, click on it once to select it.  Then, click on the
Rename button that is located below the list.

A dialog is then displayed requesting the new name.  Type in the new name and click on
Rename to rename the mailbox/folder.

Renaming a mailbox or folder

Creating a New Mailbox or Folder
New mailboxes and folders can be created using the Transfer menu, as described in the
“Creating Mailboxes During Transfers” section, or they can be created using the
Mailboxes window.

To create a new mailbox or folder, select Mailboxes from the Special menu.  Double-
click on the folder in which the new mailbox/folder is to be created to open it.  Its name is
displayed above one of the lists, and its contents are displayed therein.

Note: You can perform this function using either of the two lists in the Mailboxes
window.  It is not necessary to locate a folder in both lists before creating
a new mailbox or folder inside it.

Click on the New button that is located below the list.

Creating a new mailbox

A dialog is displayed requesting the name of the new mailbox.
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Naming a new mailbox

Type in the new name, check the Make it a Folder option if you want to do so, and click
OK.  The new mailbox/folder is displayed in the designated folder’s listing.  The newly
created mailbox/folder is also added to the Mailbox and Transfer menus.

Moving a Mailbox (or Folder) from one Folder to Another
The Mailboxes window provides the means for moving mailboxes and folders to other
folder locations.  This is why there are two lists in the window.

To begin, locate in one of the lists the folder or mailbox you want to move.  In the other
list , find and open (by double-clicking on the name) the destination folder such that its
name is displayed above the list, and its contents are displayed.  Then, select the mailbox
or folder you want to move.   Now click on the Move button that points from the list
containing the item you want to move to the list displaying the destination folder.  The
chosen mailbox/folder is moved to its new location.

Moving a mailbox, before and after
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Attachments
Any Macintosh document can be attached to and sent with a Eudora message.  To attach
a document to a current outgoing message, select Attach Document... from the Message
menu.  A standard file dialog is displayed.  Once the desired document is located, select it
and click on the Open button to attach the document to the message.

Attaching a document

The attached document functions like a “rider” to the E-mail message, and thus it does
not appear within the message text.  Instead, the name of the document and the disk from
which it was copied is displayed automatically in the Attachments: field of the message
header.

An outgoing message with an attached document
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Note: A document cannot be attached to a message through manual editing of
the Attachments: field.

When the message is sent, if the chosen document is not a plain (ASCII) text file, it is
formatted in the selected attachment format (AppleDouble, AppleSingle, or BinHex) and
sent with the message.  This allows you to send any kind of document through the mail,
even Macintosh applications.

If the chosen document is a plain text file, it is not encoded in any special format before
being sent, but rather it is added to your message as though you had typed it in manually.

Multiple Attachments
Multiple documents may be sent with a single message, but each document to be attached
must be selected as described above.

Detaching a Document
To detach a document before the message is sent out, click anywhere on the name of the
document in the Attachments: field of the composition window.  Then, press [delete] or
select Clear from the Edit menu.

Receiving an Attachment
Unless you have already specified an Attachment Folder (see the “Specifying an
Attachment Folder” section below), the first time you receive an attachment Eudora
automatically creates one for you called Attachments Folder.  This folder is created in the
Eudora Folder within your System Folder, and all arriving attachments are automatically
placed there.

Specifying an Attachment Folder
Eudora allows you to select a folder into which all incoming attachments are
automatically placed.  To do so, select Settings... from the Special menu.  Then, select
the Attachments settings.  Click on the large button beneath the Attachment Folder
prompt.

Starting to select an attachments folder

A dialog is displayed allowing you to select the desired Attachment Folder.  Double-click
on the name of the folder to select it (its name should be displayed in the menu above the
list). Then, click the Use Folder button.
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Selecting an attachments folder

The dialog closes, leaving the Settings dialog displayed.  The name of the folder you just
selected is now displayed in the Attachment Folder button.

An attachments folder is selected

If you ever want to specify a different folder to receive attachments, simply click on this
button and the dialog for choosing an attachments folder is redisplayed.

Note: If, at some future time, Eudora cannot find your selected folder (perhaps
because the volume that contained it is not available), an alert is displayed
at startup informing you that the Attachment Folder is unavailable.
Eudora will create a folder called Attachments Folder in the Eudora
folder within your System folder and use this folder for attachments until
you designate a new Attachment Folder.

Attachments are decoded automatically and saved directly into the selected folder.  The
name given your attachments is recorded in the message from which they came.  If you
receive multiple attachments with the same name, a number is added to the end of each
attachment name.
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Non-Eudora Users Receiving Attachments
If you send an attachment to someone who doesn’t use Eudora, the attached file is
included at the end of the message in the chosen attachment format (AppleDouble,
AppleSingle, or BinHex).  If the recipient does not use a Macintosh, AppleDouble is
probably the best format as it is most usable on non-Macintosh platforms.  If the recipient
does have a Macintosh, BinHex is the best format.  If the attachment is encoded in Bin
Hex, however, it is not usable until the recipient has decoded it.

Note: The application “Stuffit,” among others, can be used to decode such
documents.

Replying to, Forwarding, or Redirecting an Incoming Message
This section describes the Reply, Forward, and Redirect commands found in the Message
menu.  These commands are different from the Reply To, Forward To, and Redirect To
commands found in the same menu.  This latter set of commands is used with the Quick
Recipient list (see the “Using the Quick Recipient List” section for descriptions of these
commands).

Replying to a Message
To reply to a current message, select Reply from the Message menu.  A new message
window is displayed, with the original sender’s address automatically placed in the To:
field of the header.  The original sender’s text is also automatically included in the
message body (prefixed by “>”  at the beginning of each line).  This text may be edited as
needed.   Additional text can be added to the reply just as to any outgoing message, and
the reply can then be sent or saved for further changes.

A message and its reply
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An incoming message for which the Reply command has been used is identified by an
“R” in its message summary.

‘R’ indicates that the message has been replied to

Modified Forms of Reply
There are several variations of the Reply command.

Reply all:
If you hold down the [option] key when selecting Reply from the Message menu, the
reply message is sent to the sender of the original message and to everyone who received
it.  This is useful for carrying on group discussions electronically.  If the Reply to all By
default option in the Settings dialog (Replying) is turned on, reply to all is the default,
and you must hold down the [option] key to reply only to the message sender.

Include self:
If the Include yourself option in the Settings dialog (Replying) is turned on when you do
a Reply to all, your address is left in the address list of the new message and you receive a
copy of your own reply.  If this option is turned off, Eudora does not include your return
address in the reply to all message.

Note: To determine who you are, Eudora uses the “me” nickname, if you create
one for yourself.  If not, Eudora uses the contents of the POP Account and
Return Address fields from the Settings dialog.

CC: original To: recipients
If the Put original To: recipients in Cc: field, not To: field option in the Settings dialog
(Replying) is turned on, the addresses of the original message recipients are moved from
the To: field to the Cc: field of the reply to all message.  Only the address of the original
sender is placed in the To: field.

Quote selection only:
In some cases, you may wish to respond to only a portion of the sender’s message.  This
can be done by first highlighting the desired text in the sender’s message.  Then, hold
down the [shift] key when selecting Reply from the Message menu.  Only the highlighted
text is quoted in your reply message.

Forwarding a Message
You may want to relay, or forward, messages to other users.  To forward a current
message, select Forward from the Message menu.  A new message window is displayed,
with your address automatically placed in the From: field of the header.  The original
sender’s text is also automatically included in the message body (prefixed by “>”  at the
beginning of each line).  This text may be edited, and more text can be added to the
message.  Type the address of the person to whom you want the message forwarded in
the empty To: field of the header.  The message can then be sent or saved for further
changes.
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Forwarding a message

An incoming message for which the Forward command has been used is identified by an
“F” in its message summary.

‘F’ indicates that the message has been forwarded

Redirecting a Message
Eudora provides a way to redirect messages that you decide were more appropriately sent
to someone besides yourself.  To redirect a current message, select Redirect from the
Message menu.  A new message window is displayed.  The address in the From: field is
that of the person who originally sent the message, by way of your address.  In addition,
there are no “>” markers at the beginning of each line of the original text.  However, you
may edit or add more text to the message.  Type the address of the person to whom you
want the message redirected in the empty To: field of the header.  The message can then
be sent or saved for further changes.
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Redirecting a message

An incoming message for which the Redirect command has been used is identified by a
“D” in its message summary.

‘D’ indicates that the message has been redirected

Easy Repeat (“Canned”) Messages Using Redirect
If you find yourself sending the same message over and over again to different people,
you can keep a “canned” copy of that message and send it easily using the Redirect
command.  To do this, first compose a new message as you normally would, but leave the
To: field blank.  Save the message, and, if desired, use the Transfer menu to move it from
the Out mailbox into another mailbox (named “Canned Messages,” perhaps).  When you
want to send the message to someone, locate the message and open it (or simply highlight
it in the mailbox window), select Redirect from the Messages menu, fill in the To: field,
and send the message.

Redirect and Signatures
When you use Redirect, your signature file (described in the “Creating a Signature”
section) is not added to the message when it is sent, unless the message was originally
created by you.  Eudora considers the message to be originally from you if the address in
the From: field exactly matches your return address.
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Creating and Using Nicknames
When addressing messages, Eudora supports the use of nicknames in place of full user
names.  A nickname (sometimes called an alias) is an easily remembered, shorter
substitute for an actual E-mail address or group of addresses.  Typically, nicknames are
created for persons with whom one has repeated correspondence, and hence serve as a
typing and reference shortcut.  Eudora allows nicknames to be used in place of proper E-
mail addresses in the To:, Cc:, and Bcc: fields in the headers of outgoing messages.

To create, edit, or remove a nickname, select Nicknames... from the Special menu.  The
Nicknames window is then displayed.  This window is divided into three main fields.
The Nickname: field lists all your nicknames; the Address(es): field displays a selected
nickname’s expansion (the addresses that the nickname represents); and the Notes: field
contains your private notes on a nickname.

The Nicknames window

Adding New Nicknames
To add a new nickname, click on the New button.  The new nickname dialog is displayed
prompting you for the name of the new nickname.

New nickname dialog
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Type the name of the new nickname.  If you want this nickname to show up on the Quick
Recipient list under the Message menu (see the “Using the Quick Recipient List”
section), click on the Put it on the recipient list option.  Then, click OK.

The new nickname is displayed in the Nicknames: field of the Nicknames window, and
the insertion point is placed in the Address(es): field.  Type the complete E-mail address
of the person to be represented by the nickname.

Entering an address for a nickname

If you’d like to add someone’s proper name to the address that you specify, just put it in
parentheses after the E-mail address.

Note: Be aware that the proper name is put in the To: field of mail messages
along with the full address.

You may also type a series of many E-mail addresses (and even other nicknames),
separated by commas or returns, in the Address(es) section.  These multiple addresses are
represented by the single entered nickname.  In this way, a nickname can be used for a
group mailing list.

Using a nickname as a mailing list
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Note: The Nicknames window is the only place where it is permissible to use a
[return] to separate addresses.  Everywhere else, you must use commas.

The Notes: field can be used to enter any text you’d like to associate with a nickname,
such as the addressee’s company, title, or phone number.

Entering notes for a nickname

Note: The contents of the Notes field is not put in mail you send.

One nickname can point to another nickname, which can point to still another, and so on;
eventually, however, the nickname must end in a real address or group of addresses.  For
example, Eudora contains John in its expansion, and John is itself a nickname for
jnoerenberg@qualcomm.com.

One nickname using another nickname

Once you’ve finished typing addresses and notes, you can click the New button again to
make another nickname.

When finished making additions or changes, select Save from the File menu to save the
changes.  If you close the Nicknames window without saving the changes, a dialog is
displayed asking whether the additions/changes you just made should be saved or
discarded.
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Saving changes to Nicknames

Changing and Removing Nicknames
To change a nickname, select Nicknames from the Special menu.  Click once on the
desired nickname in the Nickname: field to select it.  Then, click the Rename button.  A
dialog is displayed allowing you to change the nickname.  You can also add or remove
the nickname from the Quick Recipient list using the Rename dialog.  Just check or
uncheck the Put it on the recipient list option.  Once the changes are completed, click
OK.

Renaming a nickname

To change a nickname’s corresponding E-mail address(es) and notes, click once on the
desired nickname to select it.  The addresses and notes associated with the nickname are
displayed in the Address(es): and Notes: fields, and may be directly edited.
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Changing a nickname expansion

To remove the nickname, click once on the desired nickname to select it.  Click the
Remove button.

When finished editing or making deletions, select Save from the File menu to save the
changes.  If you close the Nicknames window without saving the changes, a dialog is
displayed asking whether the additions/changes/deletions you just made should be saved
or discarded.

Make Nickname... Command
The Make Nickname... command can be used to make a nickname in two different ways.

From the Nicknames window itself, use command-click to select several different
nicknames, and then choose Make Nickname... from the Special menu.  The new
nickname dialog is displayed prompting you for the name of the new nickname.  Once
you have entered the name, click OK to create the new nickname with the selected
nicknames in the Nicknames window as its addressees.  This is an easy way to make a
group nickname out of existing nicknames.
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Using Make Nickname... to make a mailing list

Alternately, you can make a nickname out of the address list of a current message.  Open
a mailbox and single-click on the desired message to make it current.  Select Make
Nickname... from the Special menu.  The new nickname dialog is displayed prompting
you for the name of the new nickname.  Once you have entered the name, click OK.  If
the current message is an outgoing message, its To:, Cc:, and Bcc: fields are used for the
nickname’s addressees.  If the current message is an incoming message, its From: field is
used for the nickname’s addressees.  If multiple messages are current (i.e., you have
several message summaries selected in a mailbox window), addresses are taken from
each message and all are put in the new nickname’s expansion.

Making a nickname from current messages

Note: When an incoming message is current, Make Nickname... pretends to do a
Reply to the current message, and then takes all the recipients from the
reply message and uses them in the nickname expansion.  This means that
Make Nickname... acts just like Reply in regard to the Reply to all and
Include yourself options in the Settings dialog (Replying).  That is, if the
Reply to all option is turned on (or you hold down the [option] key), the
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nickname is made for all of the recipients of the messages plus the sender,
not just the sender.  Similarly, if the Include yourself option is turned off,
your address is not included in the new nickname’s expansion.

Using the Nicknames Window to Address Mail
The To:, CC:, and Bcc: buttons in the Nicknames window can be used to start mail
messages or to add addressees to existing current messages.  To create a new message
from the Nicknames window, select the nickname to which you want to address the mail
(you can select multiple nicknames by holding down the [command] key and clicking on
each nickname).  Then, click the To: button.

Starting a new message from the Nicknames window

A new composition window is displayed with the selected nickname(s) inserted the To:
field.

New composition window with addressee
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Once the composition window is displayed, use the To:, Cc: and Bcc: buttons to insert
additional nicknames into the corresponding fields.

Note: If you hold down the [option] key when addressing messages using the
Nickname window To:, Cc:, and Bcc: buttons, the full nickname expansion
is inserted into the appropriate message field rather than just the
nickname.

The Nicknames window can also be used to address existing messages, or new messages
created by selecting New from the Message menu.  Make sure the desired message is
current (topmost), then open the Nicknames window and use the To:, Cc: and Bcc:
buttons to address the message.

Type-to-Select in the Nicknames window
When the Nicknames window Nickname: field is selected (indicated by the bold square
around the field), you can type the first few letters of a nickname to select that nickname.
If the bold square isn’t around the Nickname: field, click once on the list to select it.

J O H

Type-to-select nickname

Nicknames and the Quick Recipient List
Nicknames and the Quick Recipient list are two separate entities.  Nicknames are used as
an abbreviation for an address or a list of addresses.  The Quick Recipient list is used to
add addresses to messages via the Message menu.  Nicknames do not need to be on the
Quick Recipient list, and not everything on the Quick Recipient list needs to be a
nickname.

However, you may have nicknames to which you often send mail, and it makes sense to
add these nicknames to the Quick Recipient list.  This is easily done from the Nicknames
window.

Examine the Nickname: field in the Nicknames window.  Notice that there is a margin
between the first letter of each nickname and the edge of the field.  Now, select a
nickname and place the mouse over the margin between the nickname and the edge of the
field.  The cursor changes into a miniature image of a menu.  Click the mouse once and a
bullet (•) is displayed in the margin area.  This bullet indicates that the nickname has been
added to the Quick Recipient list.
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The nickname is now on the Quick Recipient list

Click again, and the bullet disappears, removing the nickname from the Quick Recipient
list.  The Quick Recipient list is discussed further in the “Using the Quick Recipient List”
section.

Note: Double-clicking a nickname also puts it on or removes it from the Quick
Recipient list.

If you rename or remove a nickname that is also on the Quick Recipient list, the name on
the Quick Recipient list is also changed or removed.

Finish Nickname Command
The Finish Nickname command under the Edit menu is another nickname-related
function designed to save typing in header fields.  It allows you to type only a portion of a
nickname in the To:, Cc:, or Bcc: fields of a message, with Eudora completing the typing
task.

To use this option, type only the number of characters in the nickname that make it
unique with respect to other nicknames in the appropriate field of the message header.
Then, select Finish Nickname from the Edit menu.  The partial text of the nickname is
automatically completed in the header field.

For example, if you type an “S” in the To: field and you only have one nickname that
starts with the letter S, the Finish Nickname function completes the nickname in the
message header.

Note: If you hold down the [option] key while finishing a nickname, the
nickname’s expansion is inserted instead of the nickname itself.

Quick Recipient List
It may be more convenient to address a message by selecting a nickname or full address
from a predetermined Quick Recipient list.  This eliminates the need to type frequently
used nicknames or addresses in the fields of outgoing message headers.  By selecting a
nickname or address from the Quick Recipient list,  the address or nickname is
automatically entered in the desired field.  The list may also be used to more easily reply
to, forward or redirect messages.
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Eudora uses a single Quick Recipient list that can be accessed via the New Message To,
Reply To, Forward To, and Redirect To selections under the Message menu, the Insert
Recipient selection under the Edit menu, and the Remove Recipient selection under the
Special menu.

The Quick Recipient list

Creating the Quick Recipient List
The Quick Recipient list should consist of the nicknames or addresses of common
correspondents.  To add a nickname to this list, choose Nicknames from the Special
menu (see the “Creating and Using Nicknames” section for more details).  The
Nicknames window is displayed.  Select the desired nickname or nicknames from the
Nickname: field.  Then, click in the margin between the first letter of the nickname and
the left side of the field.  This places a bullet in the margin and adds the nickname(s) to
the Quick Recipient list.

Adding a nickname to the Quick Recipient list
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To add a full E-mail address to the Quick Recipient list, select the desired text that makes
up the full address from any current message header.  Then, select Add As Recipient
from the Special menu.

Adding an address to the Quick Recipient list

Using the Quick Recipient List
The Quick Recipient list is displayed when you select New Message To, Reply To,
Forward To, or Redirect To from the Message menu.  To utilize the list, select a recipient
using one of these commands.  Releasing the mouse button performs the action (new
message, reply, forward, redirect) and the chosen recipient is automatically inserted in the
To: field of the new message header.

Starting a message with the Quick Recipient list

More than one nickname or address from the Quick Recipient list can be added to the
To:, Cc: and Bcc: fields of any message.  To do this, first place the blinking insertion
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point in the field where you want the nickname/address to be inserted.  Then, select the
desired recipient from the Insert Recipient list under the Edit menu.  The chosen
nickname/address is placed at the insertion point and a comma is added (if necessary) to
separate the new address from the ones previously placed in the field.

Removing a Quick Recipient From the List
To remove a nickname/address entry from the Quick Recipient list, select it using the
Remove Recipient option under the Special menu.  When you release the mouse button,
the selected recipient is deleted.

Note: Removing a nickname from the Quick Recipient list does not delete it from
the Nicknames window, but removing a nickname from the Nicknames
window deletes it from the Quick Recipient list.

Finding Specified Text Within Messages
Eudora incorporates a Find function that searches for specific text within a single
message, multiple messages, or even multiple mailboxes.  To display the Find sub-menu
of commands, select Find from the Edit menu.

The Find sub-menu

Finding Text Within One Message
To search for text within a single message, open the message and make sure it is current.
Then, select Find from the Edit menu and select the Find command from the sub-menu.
The Find dialog is then displayed, with the blinking insertion point located in the text
field.

66 QUALCOMM Incorporated



Eudora User Manual Reference

The Find dialog

Type the text you want to find in the text field.  When finished entering the desired text,
click the Find button.

Starting at the insertion point of the open message, Eudora searches the current message
for the specified text.  If no match is found, the not found alert is displayed.

Unsuccessful search

If the search is successful, the message is scrolled to the first point where the match is
found and the matching text is highlighted.

Successful search

To continue searching in the same message for the next occurrence of the text, click the
Find button in the Find dialog, or select the Find Again command from the Find sub-
menu.  These commands are equivalent and limit the search to the same message.
Repeating these commands cycles through the matches in the open message only.
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Use the Find button or Find Again command  to search within the topmost message only

Enter Selection Command
If you don’t want to actually type the text in the Find dialog (for example, the text is very
long or complex), highlight it in an existing message, and then select Enter Selection
from the Find sub-menu.  This automatically inserts the selected text at the insertion
point in the Find dialog.  Then, select the Find command from the Find sub-menu to start
the search.

Finding Text Among Multiple Messages and Mailboxes
The Next, Next Message, and Next Mailbox commands are located in the Find sub-menu
(under the Edit menu) or as buttons in the Find dialog.

The Find dialog

Next Command
The Next command allows you to search for the next match of the specified text until it is
found either in the same message or among all messages in the current mailbox.

Use Next to find the next occurrence of the text string in or after the topmost message
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Note: The Next command initiated in an open mailbox (even with message[s]
selected) searches for the specified text among all messages contained in
that mailbox.  The search begins with the first selected message.

Next Message Command
The Next Message command begins the search at the message after the current message.
Eudora continues to search until it finds a matching character string, even if it has to open
more than one message or a new mailbox.

Use Next Message to skip the rest of the occurrences of the text string in the current message
and search the next message(s)/mailbox(es)

Next Mailbox Command
The Next Mailbox command begins the search for the specified text in the mailbox
following the current mailbox.  The search is conducted among all messages in that
mailbox and any subsequent mailboxes, including the In, Out, and Trash mailboxes.  The
search includes all mailboxes, even if they are contained in mailbox folders or sub-
folders.

Note: Mailboxes are searched in the order they are listed under the Mailbox
menu until the current mailbox is reached.

Use Next Mailbox to skip the rest of the occurrences of the text string in the current mailbox and
search the next mailbox(es)

Note: When the character string is found in a message, the mailbox containing
that message is checked in the Mailboxes menu.  This identifies the
location of the message.
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Summaries Only, Match Case
If you know the text you are searching for is included in a message summary, check the
Summaries Only option in the Find dialog.  When you click the Find button, Eudora
searches for the text only in the sender and subject fields of message summaries as they
appear in mailbox windows.  Eudora searches much faster when this option is checked.

The Summaries only option makes Eudora search message summaries only

Normally, Eudora ignores capitalization when searching.  If you want Eudora to consider
capitalization when searching, check the Match case option in the Find dialog.  When this
option is checked, Eudora searches for exact matches of character strings, including any
capitalization.

The Match case option makes Eudora care about capitalization

Stopping a Find
If you want to stop Eudora from continuing a search, hold down the [command] key and
type a period [.].
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Sorting Messages Within Mailboxes
It is possible to sort the message summaries in a mailbox window according to their
status, priority, sender, date, or subject.  These commands are listed in the Sort sub-menu
under the Edit menu.

The Sort sub-menu

To use any of these commands, first open the mailbox to be sorted.  Then, select the
appropriate command from the Sort sub-menu.  The mailbox’s messages are sorted when
the mouse button is released.

Eudora sorts in ascending order; the smallest item first. To sort in descending order, hold
down the [option] key while choosing the desired command from the Sort sub-menu.

Tip: Eudora’s sorting algorithm is “stable.”  This means that sorting on a
particular column leaves items of the same value in the same order as they
were before the sort.  This feature allows you to sort based on multiple
criteria by using multiple sort commands.  For example, if you want your
messages sorted by subject, and within each subject you want messages
sorted by date, first choose Sort by Date, then Sort by Subject.

Note: Sometimes Eudora does not sort by date properly.  This happens if the
mail was stored under an old version of Eudora, and the table of contents
was rebuilt, or the messages have incorrectly formatted date fields or
unknown or incorrect time zones.
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Saving A Message to a File
Eudora allows you to save a current message(s) to a separate text file on your Macintosh
system.  To do this, first display the desired message or highlight its summary in the
mailbox window.  Then, select Save As... from the File menu.  The Save As dialog is
displayed allowing you to choose a name and location for the file.

The Save As dialog

Note the two options at the bottom of the dialog.  Guess Paragraphs instructs Eudora to
remove extraneous carriage returns from the message, leaving returns only at the ends of
paragraphs.  In addition, it converts multiple spaces into tabs.

Include Headers instructs Eudora to retain the message’s header information in the saved
document.  If this is unchecked, only the body of the message is saved.

Once you’ve made your choices, click on the Save button in the dialog.

Saving a message to a text file

If you select multiple messages from a mailbox window and select Save As..., all of the
messages are saved to a single file.
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Using “Save As...” to save several messages to one file

Tip: When Eudora receives a very large message from the POP server, it splits
that message into multiple smaller messages. If you need to reassemble the
original message, use the Save As... command.

Choosing an Application for Saved Messages
When you save a message to a file using the Save As... command, the new text file is
formatted as basic ASCII text in a Macintosh document.   The document type is
determined by the program you select using the TEXT files belong to setting in the
Settings dialog (Attachments).

To do this, select Settings... from the Special menu.  The Settings dialog is displayed.
Then, select the Attachments settings.

The Settings dialog Attachments settings

Near the bottom of the dialog, click the TEXT files belong to button.  A standard file
dialog is displayed.  Using this dialog, search through your disk to locate the desired
application (probably your favorite word processing program).  Select the application and
then click Open.
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Selecting an application to open the files Save As... creates

The selected application is then displayed in the Settings dialog.

The desired application is now selected
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Resending Rejected Messages
Mail Transport Agents are computer programs responsible for routing E-mail messages
through networks.  If for some reason an E-mail message can’t be delivered to an
intended recipient, these programs return the message to the original sender.  A message
is typically rejected because of an error in the recipient’s address, although many other
reasons are possible.

The message sent back from the mail system usually includes cryptic information that
may allow you to determine the reason for the message being rejected.  It also includes
the text of the original message.

A rejected message

Eudora deletes the error messages and added text and recovers the original message so
that you can make any corrections and resend it.  To do this for the current message,
select Send Again from the Message menu.  This eliminates the inserted extra text and
reformats the message as it originally appeared.   You can then make changes or additions
and resend the message, if desired.

A rejected message, restored
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Message Priorities
Eudora allows you to assign priorities to your messages.  These priorities are for
sender/recipient reference purposes only, and they do not affect the way Eudora handles
the messages.

There are five priority levels available, each represented by a small icon.  Priorities range
from 1 (highest) to 5 (lowest).  Priority 3 is assumed for messages that have no assigned
priorities, and it is not displayed.

Highest priority

High priority
(blank)
Normal

Low priority

Lowest priority

Message priorities are displayed in the Status/Priority column of the mailbox window.

Message priorities displayed in the mailbox window

To change the priority of a message, open the message and choose the desired priority
from the Priority popup menu on the icon bar.  The selected priority icon is then
displayed in the popup window.
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Assigning a priority to a message

You can also change the priority of the current message(s) by holding down the
[command] key and pressing a number key from 1 to 5 (1 = Highest, 5 = Lowest).

When you receive mail with a priority other than Normal, Eudora adds an X-Priority:
header to the mail.  The header lists the assigned priority.

An incoming message with a pre-assigned priority

Note: All new messages are created with Normal priority, even replies to
messages whose priority you have changed.  The exception to this is that,
if the sender of a message gives it a priority other than normal, Eudora
insists on giving your reply the same priority.  You can, however, change
the priority of your response by re-assigning it manually.
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Editing Message Subjects
Sometimes the subject of a message is not clear or descriptive.  Eudora allows you to edit
the subject of any incoming message.

Note: After the are sent, the subjects of outgoing messages (messages sent by
you) cannot be edited.  However, prior to being sent, outgoing message
subjects can be changed by editing the Subject: field in the message
header.

To edit the subject of an incoming message, open it from its mailbox window.  Notice
that the subject is displayed below the title bar and above the message proper.  You may
edit this text as you would any other text.  When editing is complete, press Enter or close
the message.  The new subject is displayed in the message summary.  The contents of the
Subject: field of the message header remain unchanged.

Editing the subject of an incoming message

After Editing the subject
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Note: If you reply to the message, the original subject is used for the reply, not
your changed subject.  This gives you the freedom to put information
useful to you into the summary, without fear of your private notes being
revealed to your correspondents.

Printing
Eudora can print a current message or messages, a plain text window, or the contents of
the Ph window.  To print from within Eudora, select Print... from the File menu with the
message or item displayed.  If you have text selected in any of the above windows, you
can print just the selected text using the Print Selection... command under the File menu.

Eudora automatically prints headers and footers on each page, giving the window title,
page number and your return address.

Using the Ph Window
Eudora can access two different directory services, Ph and Finger, via the Ph window.  To
display the Ph window, select Ph from the Special menu.

The Ph window

The Ph window has two buttons (one for Ph and one for Finger), and two text fields (one
where you type your query, and one where you see the response).

Using Ph
To use the Ph protocol, the name of a Ph server must be entered in the Ph Server field in
the Settings dialog (Hosts).  To use Ph, type the name of the person you want to look up
in the query field and click on the Ph button.  The server’s response is displayed in the
response field.
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A Ph query and its response

Note: You can type any Ph command in the query field, except login commands
or commands requiring login.  For more information about the Ph server
source code, see Appendix A.

Using Finger
To use the Finger protocol, type your query into the query field.  This query should be in
the form “name@domain.”  If you omit the “@domain” segment, Eudora assumes you
mean your SMTP server host.  Once the name is entered, click on the Finger button.

The finger query is sent to the host specified in the “@domain” part, and the response is
displayed in the response field.

A Finger query and its response
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Creating a Signature
A “signature” is a brief message automatically added by Eudora to the end of outgoing
messages.  It should consist of a few lines giving the sender’s full name and E-mail
address.  Other pertinent details, such as phone number, postal address, or place of
employment are also sometimes included.

To create the signature, select Signature from the Special menu.  A blank Signature
window is displayed.  Type your signature text in this window.

Typing a signature

When you are finished typing the signature, close the Signature window.  An alert is
displayed asking if you want to save the changes to your signature.  Click Save.  You
may modify your signature at any time by repeating this procedure.

In order to activate your signature on an outgoing message, click on the signature icon on
the icon bar.

Activating your signature in the icon bar

The signature text is not displayed at the end of messages you create, but your recipients
see it.
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Settings Dialog
The Settings dialog allows you to configure Eudora.  To display the Settings dialog,
select Settings... from the Special menu.

The Settings dialog

The Settings dialog contains the following groups of settings and options: Getting
Started, Personal Information, Hosts, Checking Mail, Sending Mail, Attachments, Fonts
& Display, Getting Attention, Replying, and Miscellaneous.  Each of these groups is
described below.  The default settings are listed in brackets after the name of each
setting/option.

Note: For your convenience, some settings appear in more than one group of
settings.  For example, your real name appears in both the Getting Started
and Personal Information settings.  Changing a setting in one group
changes the setting in all groups.
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Getting Started
The Getting Started settings provide Eudora with the minimum user account information
necessary to send and receive mail.

The Getting Started settings

POP account: [none]
To receive mail with Eudora, you must have an account on a computer that runs a Post
Office Protocol version 3 (POP3 or POP) server.  This is the account to which your e-
mail messages are delivered before they are transferred to the Eudora program on your
Macintosh.  Enter your login name for this account, followed by an “@” sign and the
(domain) name of the computer.

For example, if your login name for your POP account is “carolyn,” and the name of the
computer is “uxh.cso.uiuc.edu,” type carolyn@uxh.cso.uiuc.edu in this field.

Note: If you use UUCP as your mail transport, see Appendix F.

Real Name: [none]
Enter your real name here.  It is placed in parentheses after your return address in your
outgoing mail.  It is also displayed in the Sender column of messages you send.

Connection Method: [MacTCP]
If you are using Eudora via a network connection, select MacTCP (meaning you are
using MacTCP software for communications).  If you are using Eudora via a modem,
select Communications Toolbox (meaning you are using Communications Toolbox
software for communications).  If you don’t want Eudora to attempt to make any
connections, select Offline.
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Personal Information
The Personal Information settings provide Eudora with your personal information.

The Personal Information settings

POP account: [none]
This is your POP account address.

Real Name: [none]
This is your real name.  It is the same value entered in the Getting Started settings.

Return Address: [none]
Normally, Eudora uses your POP account as your return address.  If you wish to use a
return address other than your POP account, enter it here.

Note: If you do enter an address in this field, first test the address to be sure that
mail sent to it is indeed delivered to you.  If you use an invalid return
address, no one can reply to your mail.

Dialup Username: [none]
If you use Eudora with the Communications Toolbox, and you have a secondary user
name for use during the dialup process, enter it here (this might be used as your login
name to a terminal server, for example).  See Appendix D of your user manual for details
regarding how this field can be used.
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Hosts
The Hosts settings provide Eudora with information about your servers.

The Hosts Settings

POP account: [none]
This is your POP account address.

SMTP: [none]
To send mail, a computer with an SMTP (Simple Mail Transfer Protocol) server program
is necessary.  You need not have a login on this computer, but you must have access to it
through your network.  If the computer on which you have your POP account is also an
SMTP server, leave this field blank.  Otherwise, specify the name of the computer that
you want to use as your SMTP server.

Note: If you use UUCP as your mail transport, see Appendix F.

Ph: [none]
Enter the host name of your Ph name server here.

Finger: [none]
Enter the host name of your Finger server here.  If you leave this blank, Eudora uses your
SMTP server as your Finger server.

DNS Load Balancing [off]
The DNS (Domain Name System) Load Balancing option can be used to spread the
workload of a community of Eudora users over several host computers.  Check this box if
your network administrator tells you to.

Network Administrators:  “DNS Load Balancing” works by making Eudora choose a
random address from the list of addresses returned by the DNS (without DNS load
balancing, Eudora will always choose the first address from the list).  If you have several
machines that can perform the exact same service, list all their IP addresses under one
domain name, then instruct your users to use that domain name and to check the DNS
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Load Balancing checkbox.  Now the users are equally likely to use any one of the
“balanced” machines for the service.

Checking Mail
The Checking Mail settings determine how Eudora checks for and receives your
incoming mail messages.

The Checking Mail settings

POP account: [none]
This is your POP account address.

Check For Mail Every  ?  Minute(s) [none]
If you enter a number in this field, Eudora checks your POP server for new mail at
regular intervals and transfers any mail addressed to you to your Macintosh.  The number
you enter specifies the number of minutes between checks of the POP server.  It’s a good
idea to set this at no less than 15 minutes.  Checking mail more frequently puts an
unnecessary drain on your POP server.  This option only works when Eudora is running.
Leaving this field empty disables automatic checking.

Skip big messages [off]
If Skip Big Messages is on, Eudora does not download the entire texts of very large
messages from the POP server, but only downloads the first few lines.  This can be useful
on slow connections (see the "Skip Big Messages Option" section).

Leave mail on server [off]
Eudora normally transfers your incoming messages from your account on the POP server
to your Macintosh, and deletes them from the POP server.  If this option is on, Eudora
transfers incoming messages to your Macintosh and also keeps copies on the POP server
(see the "Leave Mail on Server Option").

Send on Check [on]
If Send on Check is on, Eudora automatically sends any messages that are queued in the
Out mailbox whenever it checks the POP Server for new mail.
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Save Password [off]
If Save Password is on, you never have to enter your password to check your mail (even
if you quit Eudora and restart it) because your password is stored on your Macintosh.
Only use this option if your Macintosh is in a secure place.

Authentication Style [Passwords]
Eudora supports the use of two different network authentication technologies: Passwords
and APOP.

Sending Mail
The Sending Mail settings determine how Eudora sends your outgoing mail messages.

The Sending Mail settings

Return Address: [none]
If you wish to use a return address other than your POP account, enter it here (this is the
same value that can be entered in your Personal Information settings).

Note: If you do enter an address in this field, first test the address to be sure that
mail sent to it is indeed delivered to you.  If you use an invalid return
address, no one can reply to your mail.

SMTP Server: [none]
Specify the name of the computer which you want to use as your SMTP server.  If you
leave this field blank, Eudora uses your POP server as your SMTP server.

Immediate Send [on]
If Immediate Send is on, the rightmost button in the icon bar of the message composition
window is labeled Send.  Clicking on this button immediately sends the message to the
SMTP server.  If this option is off, the button is labeled Queue and clicking on it places
the message in the Out mailbox marked ready for delivery (Q).

QUALCOMM Incorporated 87



Reference Eudora User Manual

Send on Check [on]
If Send on Check is on, Eudora automatically sends any messages that are queued in the
Out mailbox whenever it checks the POP server for new mail.

Word Wrap [on]
If Word Wrap is on, a carriage return is not required at the end of each line of type in an
outgoing message.  Eudora automatically wraps text to the next line, with line breaks at
roughly 76 characters per line.  This makes your mail more legible to recipients using
line-oriented mail systems.  It is strongly recommended that you turn this option on.

Fix Curly Quotes [on]
If Fix curly quotes is on, Eudora replaces all “smart” quotation marks in message text or
attachments with "conventional" quotation marks prior to sending the
message/attachment.  The “smart” quotation marks are special characters, and this option
allows messages to be sent without using quoted-printable encoding.

Note: If your recipients have MIME, there’s no reason to use this option.  Only
turn it on if most of the people you correspond with don’t use MIME.

May Use Quoted-Printable [on]
If May Use Quoted-Printable is on, Eudora uses quoted-printable encoding when
necessary, such as when messages that contain long lines of text or special characters are
sent.  If this option is off, quoted-printable encoding is never used.

Keep Copies of Outgoing Mail [off]
If Keep Copies of Outgoing Mail is on, a copy of each sent message is kept in the Out
mailbox (their summaries are marked with an “S” in the Status column of the Out
mailbox window).  If this option is off, Eudora moves outgoing messages to the Trash
mailbox after they are sent.

Use Signature [on]
If Use Signature is on, Eudora automatically attaches your signature file (if you have one)
to the end of outgoing messages.
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Attachments
The Attachments settings determine how Eudora sends and receives attachments.

The Attachments settings

Encoding Method [BinHex]
The Encoding Method option allows you to select what format documents attached to
outgoing messages are encoded in: AppleDouble, AppleSingle or BinHex.  AppleDouble
is best for recipients with MIME; AppleSingle is best for recipients with MIME if you are
sure the recipient is on a Macintosh; BinHex is most compatible with old Macintosh
mailers and previous versions of Eudora.

Always include Macintosh information [off]
The Always include Macintosh information option allows you to include or omit
Macintosh resources and types from attachments if they are basic MIME types.  It can be
used to omit this information from attachments when sending them to non-Macintosh
users whose e-mail systems are confused by this information.

Attachment Folder: [none]
Eudora automatically places file attachments that come with messages into the specified
Attachment Folder.  To change the setting, single-click on the folder name button (the
default is blank).  A dialog is displayed allowing you to select the attachment destination
folder.

TEXT files belong to: [TeachText]
When you choose Save As... from the File menu, Eudora creates a Macintosh document
that is saved for the application named in this field.  That is, when you double-click the
saved file, this application is used to open it.  You may want to set this option to your
favorite word processing program.  To change the setting, single-click on the application
name button (the default is TeachText).  A dialog is displayed allowing you to select the
application.

QUALCOMM Incorporated 89



Reference Eudora User Manual

Fonts & Display
The Fonts & Display settings determine how Eudora displays messages.

The Fonts & Display settings

Screen Font, Size: [Mishawaka, 9]
This popup menu allows you to select a screen font to be used for displaying the text of
your Eudora messages and mailbox windows.  Type the size (in points) of the font you
want to use in the Size field.

Print Font, Size: [Courier, none]
This popup menu allows you to select a font to be used when you print messages using
the Print... command.

Message Window Width: [80]
This field specifies the width of new and received message windows (in characters).  If
you leave this field blank, the default value is 80.  This setting has no effect on what your
mail looks like when it is sent.  When mail is sent, Eudora wraps at or before 76 columns.

Note: If you use a proportional font, Eudora sets the window width based on the
width of the “0” character.

Message Window Height: [none]
This field specifies the height of new and received message windows (in lines).  If you
leave this field blank, the default value is 20.

Note: If the Zoom windows when opening option is turned on, received messages
window heights are automatically adjusted to the length of the message
text.

Zoom windows when opening [off]
If this option is on, new mailbox and message windows automatically open to their
“zoomed” size.  The zoomed size is computed on a window-by-window basis.  For
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mailbox windows, zoomed size is just wide enough to display the widest summary, and
just long enough to display all the summaries (but no longer than the Macintosh display
screen).  For message windows, zoomed size is just long enough to display all of the
message (but no longer than the Macintosh display screen), and as wide as the Message
Window Width setting.  Composition windows zoom to the height specified by the
Message Window Height setting.

Getting Attention
The Getting Attention settings determine what Eudora does when it is running in the
background and wants your attention, or when new mail arrives.

The Getting Attention settings

Use an alert [on]
If this option is on, Eudora uses an alert dialog to notify you when new mail is received.

Flash an icon in the menu bar [on]
If this option is on, Eudora flashes an icon in the menu bar when it needs you.  Eudora
uses two different icons – a Mail flag when you have new mail and an envelope with an
exclamation point in it for everything else.

The new mail and attention icons

Open mailbox (new mail only) [on]
This option applies only to the arrival of new mail.  If it is on, Eudora automatically
opens mailboxes when new mail arrives and is placed in them.  It also scrolls to the end
of the mailboxes and selects the first unread message of the last unread batch of
messages.  If this option is off, Eudora doesn’t open mailboxes when new messages
arrive.
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Play a sound [on]
If Play a sound is on, Eudora makes a noise when it needs you.  There are two different
sounds, one for the arrival of mail and one for everything else.

Replying
The Replying settings determine what Eudora does when you are generating replies to
incoming messages.

The Replying settings

Reply to all:

By default (option for sender) [off]
If Reply to all By default is on, selecting Reply from the Message menu creates a
message addressed not only to the sender of the original message, but also to all of its
recipients.

When option key is down [on]
If Reply to all When option key is down is selected, the [option] key must be depressed
when creating the reply message if you want to reply to all.  Otherwise, the reply message
is only addressed to the original sender.

When replying to all:

Include yourself [off]
If Include yourself is on, when you do a Reply to all (as described above) your address is
left in the address list of the new message and you receive a copy of your own reply.  If
this option is off, your address is removed from the reply message and you do not receive
a copy of the reply.

Note: To determine who you are, Eudora uses the “me” nickname, if you have
one.  If not, it uses the contents of the POP Account and Return Address
fields from the Settings dialog.
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Put original To: recipients in Cc: field, not To: field [off]
If this option is on, the addresses of the original message recipients are moved from the
To: field to the Cc: field of the reply to all message.  Only the address of the original
sender is placed in the To: field.

Copy original’s priority to reply [on]
If this option is on, a reply message generated by you will have the same priority as the
original message.

Miscellaneous
These settings control miscellaneous functions.

The Miscellaneous settings

Switch messages with:

Unmodified arrow keys [off]
If this option is on and there is a message window open on the screen, the Macintosh
keyboard arrow keys can be used to close the current message and open the next or
previous message in the mailbox.  The up or left arrow key opens the previous message;
the down or right arrow key opens the next message.  If this option is off, the arrow keys
can be used to move the insertion point in messages.

Note: Even if Unmodified arrow keys is on, the arrow keys do not switch
messages if there is a message composition window topmost on the screen.

Command-Arrows keys [on]
If this option is on, you can switch messages (as described in the “Unmodified arrow
keys” section above) by holding down the [command] key and then pressing the arrow
keys.

Note: The command-arrows keystrokes do work when composition windows are
open on the screen.
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Require confirmation for delete [on]
If this option is on, Eudora alerts you when you are deleting messages you haven’t read
or transferring queued messages out of the Out mailbox.

Close messages with mailbox [off]
If this option is on, closing a mailbox window closes all open messages from that
mailbox.

Empty Trash on Quit [on]
If this option is on, Eudora empties the Trash mailbox whenever you quit the application.
If Empty Trash on Quit is off, Eudora only empties the Trash when you select Empty
Trash from the Special menu.

Note: If you want to remove some messages from the trash but don’t want it
emptied entirely, highlight the summaries you want to delete and select
Delete from the Message menu.  The selected messages are deleted.

Say OK to alerts after 2 minutes [off]
Many network problems are temporary.  When a problem occurs while Eudora is
transferring or checking your mail, you are notified in the same way you would be if you
were receiving new mail.  If this option is on, these notifications automatically go away
after a couple of minutes.  This allows Eudora to try the communication again.  This
setting is most useful if you have automatic mail checking enabled.

Note: Turning this option on may cause some Communications Toolbox
connection tools to give you less progress information.

Automatically open next message [on]
If this option is on, deleting or transferring the current message opens the next message in
the mailbox, but only if it is unread.

Balloon Help
Eudora has extensive Balloon Help.  From the Balloon Help menu, choose Show
Balloons to turn this function on.  Move the mouse pointer to a Eudora menu selection or
item on the screen to display a brief description of that item (see the example below).
When you no longer require assistance, choose Hide Balloons to turn Balloon Help off.

Note: If you have an extended keyboard with a [help] key, it can be used to turn
Balloon Help on and off.
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Help balloon example

It’s possible to turn balloon help on even when a dialog is displayed. If you’re not sure
how to respond to a dialog, try balloon help.

Quitting Eudora
To quit the Eudora program, select Quit from the File menu.  If you have queued
messages, or timed messages due to be sent in the next 12 hours, you are asked if you
want to send them (see the “Quitting with Queued Messages” section).  If the Empty
Trash on Quit option in the Settings dialog (Miscellaneous) is turned on, quitting Eudora
also empties your Trash mailbox.
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Mail Storage
The first time you start Eudora, it creates a Eudora Folder within your System Folder.
Even though you do not need to access the Eudora Folder during normal operation, this
section is provided to show you where Eudora stores your mailboxes and messages.

Eudora Settings
Your Settings information is saved in the Eudora Settings file, along with your Quick
Recipient list and the list of open windows (Eudora reopens the windows the next time
you start the program).

Eudora Nicknames
Your nicknames are saved in the Eudora Nicknames file.

Note: This file is a plain TEXT file in UNIX “.mailrc” format.

In, Out, and Trash
These files hold your mail.  You’ll see files like these for every mailbox you create.

Note: These files are in UNIX mail format.

In.toc, Out.toc, and Trash.toc
These files are the tables of contents for your mailboxes.  They make it much faster for
Eudora to access your mail.  You’ll see files like these for every mailbox you create.
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Eudora Log, Old Log
Eudora keeps records of all mail transfers.  These records are kept in the Eudora Log and
Old Log files.  The Old Log file is overwritten and a new Eudora Log file is created when
the Eudora Log file reaches its approximately 100K maximum size.

System 7 Aliases
Eudora supports the use of aliases for mailbox and .toc files that, for some reason, you
have moved to a location outside the Eudora Folder.  This allows you to open these
mailboxes from within Eudora.  Place Eudora aliases in the Eudora Folder or a sub-folder
within the Eudora folder.

Sharing a Macintosh with Other Users
If you are sharing a Macintosh with other users, make a copy of the Eudora Folder for
each user.  The copies can be named whatever you like, and put anywhere you like,
including on floppies or network volumes.  To tell Eudora which folder to use, launch
Eudora by double-clicking on the Eudora Settings file in that folder.

Sharing one Macintosh among multiple Eudora users
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A Word About Memory
Eudora alerts you if it is running low on memory.

A low memory alert

When this alert is displayed, quit Eudora and assign it additional memory.  To do this, use
the Finder to locate the Eudora application file and single-click on it to select it.  Select
Get Info from the Finder’s File menu to display the Eudora Info dialog.  Type the
amount of memory you want Eudora to have in the Current size field.  Then, close the
window and restart Eudora.

Changing Eudora’s memory size

You can see Eudora’s estimate of how much memory it needs at any given time by
choosing About Eudora... from the Apple menu with the Eudora application running.
Eudora estimates the amount of memory it needs based on your open windows and the
size of the In, Out, and Trash mailboxes (which are constantly in use).  The best way to
reduce how much memory Eudora needs is to clean up these mailboxes regularly or use
other mailboxes for long-term mail storage.

Note: There’s no harm in giving Eudora more memory than it asks for.  Eudora
is giving you the minimum suggested memory when it suggests size.
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Summary of Eudora Menu Commands
File
This menu provides basic file and mail program functions.

New Text Document
Create a new text file.

Open...
Open the selected message summary, or open a text file, or
open a Eudora Settings file.

Close
Close the current window.

Save
Save changes to the contents of the topmost window.  This
applies to composition windows, text windows, and the
Nicknames window.

Save As...
Save the current message(s) to a plain text file.

Send Queued Messages
Send all messages that have been queued for delivery.

Check Mail
Pick up new mail from the POP server.

Page Setup...
Set printing options.

Print...
Print the current message(s), text window, or Ph window.

Print Selection...
Print the current selection from a message, text window, or Ph
window.

Quit
Quit the Eudora application.
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Edit
This menu provides text editing and sorting tools.

Undo
Reverses the last editing action taken on a piece of text.

Cut
Delete selected text and place it on clipboard.

Copy
Copy selected text and place it on clipboard.

Paste
Place contents of clipboard at chosen insertion point in
message.

Paste as Quotation
Place contents of clipboard at insertion point, with ‘>’
characters at the beginning of each line to denote quoted text.

Clear
Delete selected text.

Select All
Select entire contents of message or mailbox.

Show Insertion Point
Scroll selection or insertion point into view.

Wrap Selection
Insert returns into the current selection, in the same way as
Eudora does when it sends mail.  With the [option] key,
unwrap text the way Save As... does when Guess Paragraphs
is turned on.

Finish Nickname
Complete the partial text of a nickname in the field of a
message header.

Insert Recipient
Insert the chosen nickname/address from the Quick Recipient
list at the insertion point.

Find
Search for designated text or a character string within
message(s).

Sort sub menu
Sorts message summaries in a mailbox.  Hold down the
[option] key to reverse the order of the sort.
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Mailbox
This menu lets you open a mailbox, or bring an open mailbox to the front.

In
Open mailbox where incoming messages are stored until
deleted or transferred to another mailbox.

Out
Open mailbox where messages you compose are stored, and
where queued messages are held until actually sent, and
where copies of sent messages may be initially stored.

Trash
Open mailbox where deleted messages are stored.

[Your Mailboxes]
Mailboxes you create are also displayed in this menu.

QUALCOMM Incorporated 101



Reference Eudora User Manual

Message
This menu lets you create and delete messages.

New Message
Open new message composition window.

Reply
Reply to the sender of the current message.

Forward
Forward the current message to someone else.

Redirect
Forward the current message to someone else, but make the
return address be the person who originally sent the message.

Send Again
Resend a message rejected by the mail system.  Be sure to fix
whatever caused the problem before you queue the message.

New Message To
Send a message to someone on the Quick Recipient list.

Reply To
Reply to the current message, but send the reply to someone
on the Quick Recipient list.

Forward To
Forward the current message to someone on the Quick
Recipient list.

Redirect To
Redirect the current message to someone on the Quick
Recipient list.

Queue For Delivery
Save the message in the Out mailbox and mark it as queued,
or ready to be delivered.

Change Queueing...
Queue a message, unqueue a queued message, or set a
message for timed send.

Attach Document
Attach file(s) to the current message.

Delete
Transfer the current message to the Trash mailbox; also used
for deleting messages from the Trash mailbox.
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Transfer
This menu lets you transfer current message(s) to the selected mailbox.

In
Transfer the current message(s) to the In mailbox.

Trash
Transfer the current message(s) to the Trash mailbox.

New...
Display New Mailbox dialog to create a new mailbox; current
message(s) may be transferred into that mailbox.

[Your Mailboxes]
Transfer the current message(s) to the selected mailbox that
was previously created by you.
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Special
This menu provides additional Eudora functions.

Make Nickname...
Create a nickname for an address or addresses in the current
message.

Add As Recipient
Add selected text to the Quick Recipient list.

Remove Recipient
Select a recipient from this menu and the recipient is removed
from the Quick Recipient list.

Empty Trash
Delete all messages from the Trash mailbox.

Compact Mailboxes
Reclaim unused space in mailboxes.

Settings...
Display the Settings dialog.

Communications...
Display the Communications Toolbox settings (not needed
when using MacTCP).

Forget Password
Make Eudora ask for your password the next time it checks
for mail.

Change Password...
Change your password on the POP server computer.  This
requires a special server.
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Window
All Eudora window titles are listed in this menu.  Select one to open it or bring it to the front.

Mailboxes
Display the Mailboxes window.

Nicknames
Display the Nicknames window.

Ph
Display the Ph window.

Signature
Display the Signature window.

Send to Back
Send the topmost current window to the back of all displayed
windows.

[Mailbox Windows]
Toggle between open mailboxes.
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Eudora Information
The information in this manual was correct at the time of printing.  However, things
happen very quickly in the electronic world, meaning that some of this information may
already be out of date.  For the very latest information about Eudora, send E-mail to
eudora-info@qualcomm.com.

Update Announcements
If you would like to receive announcements about updates to Eudora, send E-mail to
listserv@vmd.cso.uiuc.edu.  The text of the message should consist of “sub eudora your-
first-name your-last-name.” Be sure you don’t put anything else in the body of the
message, including your signature.

Obtaining a POP Server
If you would like to run a POP server on your own UNIX system, we suggest you use
“popper.”  Popper is available by anonymous ftp from ftp.cc.berkeley.edu.

VAX/VMS systems may try the “Multinet” package from TGV, or IUPOP3, available for
anonymous ftp from ftp.indiana.edu.

For VM/CMS users, there is a port of “popper” available for anonymous ftp from
vmd.cso.uiuc.edu (cd to the “POPD” directory).

Ph Server Source Code
A server for the “Ph” protocol is available for anonymous ftp from uxc.cso.uiuc.edu.  The
filename is pub/qi.tar.Z.

Password Change Server
Three sample UNIX servers for Eudora’s “Change Password” command are available in
the Eudora Q&A stack.

Network Products Installer
The current version of the Network Products Installer disk can be had by anonymous ftp
to ftp.apple.com, dts/mac/sys.soft/netcomm subdirectory.

MacTCP
Contact Apple Software Licensing, sw.license@applelink.apple.com.
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Spellswell
For information on obtaining Spellswell, contact Working Software, Inc. at:

P.O. Box 1844
Santa Cruz, CA  95061-1844
Phone: (408) 423-5696
Fax: (408) 423-5699
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Modifier Keys
Many operations in Eudora can be affected by holding down one or more “modifier”
keys.  Eudora uses the [shift], [option] and [command] keys as modifiers.

The [shift] key is usually used to “constrain” things – to keep them from happening or
make them happen in a limited way.

• [shift] + Opening Eudora stops Eudora from checking for mail at startup, even if you
have a mail checking interval set.

• [shift] + Reply instructs Eudora to copy only the selected body text to the new
message.  This is sometimes easier than having Eudora copy it all and then deleting
what you don’t want.

• [shift] + To:, Cc:, or Bcc: in the Nicknames window does not bring the composition
window to the front after inserting the name.

• [shift] + Check Mail instructs Eudora to check for mail and resets the checking interval
(normally, checking mail manually doesn’t affect when the next automatic check is
done).

• [shift] + Print instructs the printer to print the selected text only.

The [option] key is usually used to make an operation to reverse option settings.

• [option] + Insert a nickname inserts the full nickname expansion in the specified field.

• [option] + finish a nickname inserts addresses instead of nickname.

• [option] + Queue or Send button brings up Change Queuing dialog.

• [option] + Save instructs Eudora that all open windows are to automatically reopen at
the next startup.

• [option] + Reply toggles the “Reply to all” option in the Settings dialog.  If the Reply
to all option is turned on, Option + Reply generates a reply to the sender only.  If the
Reply to all option is turned off, Option + Reply generates a reply to all addresses in the
message header.

• [option] + Transfer sends a copy of the current message to the selected mailbox and
retains the original message in the original mailbox.

• [option] + Open a message shows all headers.

The [command] key is also sometimes used as a modifier.

• [command] + drop a document onto Eudora attaches the document to a message, even
if the document is one Eudora could have opened.

Other Important keys
The arrow keys, depending on the settings in the Settings dialog, can move you from one
message to another in a mailbox,

• up/left arrow or [command] + up/left arrow takes you to the previous message.
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• down/right arrow or [command] + down/right arrow takes you to the next message.

The [enter] key performs several different functions:

• It selects the outlined button in any dialog, alert, or window.

• It opens the selected message(s).

• It lets you begin or end editing the subject of a message.

The [esc] key (or [command] + .) stops any operation currently in progress.

If you have an extended keyboard, the following keys are also useful:

• [help] turns Balloon Help on or off.

• [F1] is Undo.

• [F2] is Cut.

• [F3] is Copy.

• [F4] is Paste.

• [del] deletes the character to the right of the insertion point.

• [home] scrolls the window to the beginning.

• [end] scrolls the window to the end.

• [page up], [page down] scrolls up or down through the window.

[command] + Key Equivalents
[command] + [.] Stops Eudora ‘s current action

[command] + [A] Select all

[command] + [B] Move window behind another window

[command] + [C] Copy

[command] + [D] Delete message

[command] + [E] Queue an outgoing message

[command] + [F] Open Find window (search for message)

[command] + [G] Find again

[command] + [H] Attach document to outgoing message

[command] + [I] Open In mailbox

[command] + [K] Make nickname

[command] + [L] Open Nicknames window

[command] + [M] Check mail

[command] + [N] New message

[command] + [O] Open message

[command] + [P] Print message

[command] + [Q] Quit Eudora
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[command] + [R] Reply to message

[command] + [S] Save message without sending

[command] + [T] Send queued messages

[command] + [U] Open Ph window

[command] + [V] Paste

[command] + [W] Close message

[command] + [X] Cut

[command] + [Z] Undo
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Introduction
Eudora uses Simple Mail Transfer Protocol (SMTP) to transfer your outgoing mail to
your SMTP server machine, which in turn uses SMTP to send your mail to the world at
large.  Mail from the world at large arrives on your Post Office Protocol (POP) server,
where it waits for Eudora to pick it up with Post Office Protocol, version 3 (POP3).  The
mail Eudora sends and receives is constructed in accordance with RFC 822 and RFC
1341 (MIME).

Your Macintosh POP/SMTP
Server

The World at Large

POP
Check Mail

SMTP
Send Queued Messages

SM
TP

Eudora mail transport overview

Outgoing Mail
When you send an E-mail message to someone, Eudora uses SMTP to send the mail to
your local SMTP server computer.  That computer then sends the mail to your
addressee’s computer, also (usually) by means of the SMTP protocol.

Why doesn’t Eudora talk directly to your addressee’s computer?  For one thing, it would
take a lot longer for your mail to leave your Macintosh, because your Macintosh would
have to call up each addressee’s computer and deliver your mail.  For another, some
computers are “hard to find;” it’s much better to let another computer “hunt” for your
addressee than to make your Macintosh do it.  Finally, sometimes your addressee’s
computers won’t be available when you want to send mail.  The SMTP server handles
this by holding your mail until the other computer is ready to accept  it, eliminating the
inconvenience of having unsent messages hanging around on your Macintosh.
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Incoming Mail
When somebody sends you mail, other computers use the SMTP protocol to deliver the
mail to your POP server.  Your POP server puts mail in your “mail drop,” where it stays
until the Eudora program picks it up.  When you check your mail, Eudora uses POP3 to
pick up your mail and move it to your Macintosh.

Why doesn’t Eudora use SMTP to receive your mail?  SMTP works best when the
computers it knows about are always ready for mail.  Unless you wanted to run Eudora
and your Macintosh 24 hours per day, seven days a week, SMTP wouldn’t work very
well for you.  It also doesn’t work well in lab environments, where you might use any
number of different Macintoshes.

More Information
If you want to know more about the Internet in general, consult the book Internetworking
with TCP/IP, by Douglas Comer, 1988, Prentice-Hall ISBN 0-13-470154-2 025.

If you want to know more about SMTP, RFC 822, POP3 and MIME, the official
standards are:

RFC 821, “Simple Mail Transfer Protocol,” by Jonathan B. Postel

RFC 822, “Standard for the Format of Internet Text Messages,” by Ned Freed and
Nathaniel Borenstein

RFC 1225, “Post Office Protocol, Version 3,” by Marshall Rose

RFC 1341, “Multipurpose Internet Mail Extensions,” by Dave Crocker

You can find the RFC’s by anonymous ftp to nic.ddn.mil; see Internetworking with
TCP/IP for details.
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Introduction
Eudora is designed for use with MacTCP or for dialup to Cisco terminal servers. It can be
used with other dialup connections as well.  Complicated setups are likely to be
unreliable, but if the setup commands to connect are simple, Eudora works well.

These instructions assume you are familiar with ResEdit, your communications
equipment and your hosts.  It is suggested that one person make these changes to Eudora
and then redistribute the customized version to other users at your site.

Macintosh Requirements
To use Eudora over a dialup connection, you must have the Communications Toolbox
installed.  System 7 has it built in.

Dialup Requirements
Eudora needs a “transparent” connection to your POP, SMTP, and (optionally) Ph
servers.  Transparent means primarily two things:

1. Characters Eudora sends should NOT be echoed back to Eudora.  Most
systems do echo characters, so something special may need to be done to
achieve this.

2. You must pay close attention to how carriage returns are treated.  UNIX
systems routinely translate carriage returns into linefeeds; you must
either disable this on your system or teach Eudora how to deal with it.

Navigation
Eudora has a very rudimentary scripting system built in.  This capability is called
“navigation” to separate it from the rather sophisticated connotations of “scripting.”

Navigation is simple; Eudora uses a list of strings which it sends out the serial port one at
a time.  After each string, it waits until there is no output from the remote system for 2
seconds or until a given string is matched, after which Eudora continues with the next
string.

There can be three sets of navigation strings contained in STR# resources:  one is used
when connecting (Navigate In); one is used when disconnecting (Navigate Out); and one
is used when switching from SMTP to POP (Navigate Mid).  You may use ResEdit to
manipulate these resources.  Any of the resources may be absent, in which case Eudora
skips the navigation it would otherwise have done with that resource.

For each function, Eudora selects an appropriate resource in the following manner.  First,
it takes the name of the connection tool currently in use (e.g., “Apple Modem Tool”);
then, it appends a space and the current type of navigation (e.g., “Navigate In”).  Eudora
looks for an STR# resource with that name (e.g., “Apple Modem Tool Navigate In”).  If
that is not found, Eudora looks for an STR# resource named after the navigation type
(e.g., “Navigate In”).  Finally, it looks for specific resource ids (2400 for Navigate In,
2600 for Navigate Out, and 4200 for Navigate Mid).  The first STR# resource found is
the only one used.
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Navigation resources can be in the Eudora application itself, in your Eudora Settings file,
or in a plug-in file (type “rsrc” and creator “CSOm”). Plug-in files are highly
recommended. Most of the time, plug-ins are kept in the Preferences or Eudora Folder
within your System Folder.

Special Sequences in Navigation Resources
Eudora provides a set of special character sequences for use in Navigation resources.
These sequences are all two characters long, the first character being a backslash. They
are either replaced with items from your Eudora settings, or they modify the Navigation
process.

Replacements
These special characters are replaced with strings.  They can appear at any place in a
navigation string.

\u POP account user name.

\h POP account host name.

\p POP account password.

\s SMTP server host name.

\U Dialin user name.

\P Dialin password.

\n A linefeed (ASCII 10).

\r A carriage return (ASCII 13).

\\ A single backslash character.

Modifiers
\b Hide from Progress window.

\D Delay.

\B Break.

\e Expect something.

\b – when this appears as the first character in a given a string, Eudora won’t print the
string in the Progress window when it is sent.  This is useful for passwords or other state
secrets.

\D – should be the first character in the string and followed by digits.  The digits are taken
as a number of seconds to delay (e.g., “\D2” is a two-second delay).  As with other
strings, Eudora will wait for output to stop for two seconds, or for an expect string, before
proceeding.

\B – should be the first character in the string and followed by digits.  The digits are taken
as the number of ticks (60ths of a second) to send a break signal (e.g., “\B30” is a half-
second break).  As with other strings, Eudora waits for output to stop for two seconds, or
for an expect string, before proceeding.

\e – makes Eudora expect to see a specific string in the output from the dialup server.
Eudora sends whatever comes before the \e, and then waits for whatever comes after it to
occur in the data sent from the host.  There are two caveats to this.  First, Eudora only
matches on the first 7 bits; the high bit of each character is ignored for matching.  This is
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needed for systems that use parity.  Second, Eudora’s matching is fast and sloppy; highly
repetitive data streams and long expect strings might fool it (for example, Eudora
wouldn’t see “Login:” if your server said: “LogLogin:”).

Eudora follows its normal time-out process when looking for an expect string.  That is,
after 45 seconds Eudora asks you if you want to keep waiting or cancel the process.  If
you cancel, the connection process is stopped.

If you use either of the password replacement sequences (“\p” for your POP account
password or “\P” for your dialup password) in the same string as an expect, Eudora
assumes the password is wrong if the expect string isn’t found.  This causes Eudora to ask
for your password the next time it tries to connect.

Connecting to Servers
Once the navigation is done, Eudora issues a command to connect to the proper port of
the server you are using.  Once this command is sent, the connection MUST be
transparent, as discussed above; no echoes and no carriage return translation.  Eudora
comes configured to send the command:

telnet hostname portnumber /stream<return>

The “<return>” means a carriage return in this document only; you must type actual
carriage returns in ResEdit.  A template for the command is kept in 7400.13 (“7400.13” is
shorthand for STR# resource id 7400, string 13).  The template begins life as “telnet %p
%d /stream\n”.  The %p is replaced with the hostname and the %d with the port number.
It is acceptable to change this string however you please, except that %d, if it is used,
must come after %p.  The best way to change this string is not to modify it, but to
override it.  You can do this by creating an ‘STR ’ resource of id 7413 and putting the
string you want Eudora to use in that.

A Return By Any Other Name
When Eudora is communicating with your POP or SMTP server, it’s important that they
agree on what constitutes a line.  The Internet specification stipulates that a line ends with
a carriage return followed by a linefeed.  Most UNIX systems will “helpfully” translate
carriage returns into linefeeds.  If you can’t get that feature turned off, it may help to
make Eudora send only a carriage return, and not the carriage return/linefeed pair.  You
may edit 6000.17 to be what you want Eudora to send at the end of a line.  The best way
to change this string is not to modify it, but to override it.  You can do this by creating an
‘STR ’ resource of id 6017 and putting the string you want Eudora to use in that.

An Example: Direct Connection To A UNIX Box
Here’s a suggest connection method if your Macintosh has a serial line to a UNIX
machine, or if there are modems on your Macintosh and UNIX machine.

1. Install the srialpop program on your UNIX system.  Source to this is part of the
Eudora distribution.

2. Put the following strings in the “Navigate In” resource.

1: \r\r\r\egin:

2: \u\r\eword:

3: \p\r\r\r\e%

4: exec srialpop
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3. Put one empty string in the “Navigate Mid” resource.

Resources for dialing directly into a UNIX machine.

That’s it.  Srialpop takes care of the terminal settings for you.

Note: A plug-in with these strings in it is part of the Eudora distribution.  The
file name is “Direct UNIX Navs.”

Need More Options?
If Eudora’s scripting doesn’t cut it for you, there are a couple of alternatives.  One is the
Calypso connection tool.  It lets you use CCL scripts for the connection/disconnection
process.  Calypso can be found on major Macintosh archive sites.  The other is the Simon
Fraser University version of Eudora, which has a powerful built-in scripting language.
This is available for anonymous ftp from ftpserver.sfu.ca, pub/mac/eudora sub directory.
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Introduction
This appendix discusses in detail how Eudora handles character sets and character set
transliteration.

Terminology
Before discussing how Eudora handles character sets, there are some terms that need to
be defined.

A character is a basic unit of written language; a letter, number, punctuation mark (or in
some languages, a whole word or phrase).  Major modifications to a letter (for example,
capitalization or the addition of an accent mark) make that letter a separate character unto
itself.  “A”, “a”, “à”, and “á” are all different characters, as are “B”, “0”, “.”, and so on.

A character code is a number that is used to represent a given character.  Since
computers really work only with numbers, character codes are required to allow
computers to deal with letters, words, and even user manuals.

A character set is a group of characters and their character codes.  For example, we might
decide to base a character set on the English alphabet, and simply number the capital
letters from 1 to 26:

1
2
3
4
5
6
7
8

10
11
12
13
14
15
16
17

19
20
21
22
23
24
25
26

A
B
C
D
E
F
G
H

J
K
L
M
N
O
P
Q

S
T
U
V
W
X
Y
Z

A Simple Character Set

Now, if we wanted to spell “CAT”, we’d use the numbers 3, 1, and 20.

The “US-ASCII” Character Set
The character set described above is a simple one.  Too simple, in fact.  What if you want
to spell “The cat sat on the mat.”?  You can’t, because there are only capital letters and no
space or period.  A long time ago, a character set was devised to fit much common United
States English usage.  This character set has come to be known as “US-ASCII.”  It is
considerably richer than just capital letters:
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96
97
98
99
100
101
102
103
104
105
106
107
108
109
110
111

`
a
b
c
d
e
f
g
h
i
j
k
l
m
n
o

0
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15

tab
lf

cr

32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47

space
!
"
#
$
%
&
'
(
)
*
+
,
-
.
/

64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79

@
A
B
C
D
E
F
G
H
I
J
K
L
M
N
O

16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31

112
113
114
115
116
117
118
119
120
121
122
123
124
125
126
127

p
q
r
s
t
u
v
w
x
y
z
{
|
}
~

48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63

0
1
2
3
4
5
6
7
8
9
:
;
<
=
>
?

80
81
82
83
84
85
86
87
88
89
90
91
92
93
94
95

P
Q
R
S
T
U
V
W
X
Y
Z
[
\
]
^
_

The US-ASCII Character Set

Using US-ASCII, you can write “The cat sat on the mat.”, using this sequence of
numbers: 84, 104, 101, 32, 99, 97, 116, 32, 115, 97, 116, 32, 111, 110, 32, 116, 104, 101,
109, 97, 116, 46.

The US-ASCII character set is the one in widespread use on the Internet.  Most Internet
programs assume you are using it, and most Internet programs don’t support any other.
However, what if you want to write “André sat on the mat.”?  There is no character code
in US-ASCII for “é”; so how do you tell the computer what you mean?

122 QUALCOMM Incorporated



Eudora User Manual Appendix E – Transliteration

The Macintosh Character Set
The Macintosh allows us to describe our friend André’s perching habits.  The most
common Macintosh character set has a character code for “é”, as well as many other non-
US characters.
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The Macintosh Character Set

As you can see, the Macintosh character set is much larger than US-ASCII.  In fact, it’s
twice as large.  The first half (character codes from 0 to 127) of the Macintosh character
set is the same as US-ASCII.  However, there are another 128 characters, with character
codes from 128 to 255.

So, using the Macintosh character set, we can write “André sat on the mat.”, because
there is a character code for “é”, 142.

The ISO Latin-1 Character Set
Unfortunately, not everyone uses a Macintosh, so not everyone has access to the
Macintosh character set.  The character sets that other computers use vary greatly.  Most
of them use character sets that are the same as US-ASCII for character codes from 0 to
127.  However, if they provide characters beyond US-ASCII, they often do so with
character codes other than the ones chosen by the Macintosh.  That is, on some computers
“é” doesn’t have a character code of 142, but might instead have a character code of 237.
So, if they sent you some text with “André” in it, it would come out on your screen as
“AndrÌ”, which would not be terribly effective.
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In order to solve this sort of problem, some standard character sets have been agreed to.
One popular character set is called “ISO Latin-1,” or “ISO-8859-1.”
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The ISO Latin-1 Character Set

One computer can tell another “Let’s use ISO Latin-1,” and then both computers will
know that the character code for “é” is 233 when they’re talking to each other, even
though one may usually use 142, and the other might usually use 237.

Quoted-Printable Encoding
There is, however, a problem with using the ISO Latin-1 character set.  SMTP (the
protocol used to move mail around the Internet) cannot use character codes greater than
128.  So our beautiful “é”, with its character code of 233, cannot be sent over the Internet.
If you try, chances are it will get 128 subtracted from its value, making it 105, which is
“i”.  “André” becomes “Andri”, which just won’t do.

This problem is avoided by the use of “quoted-printable” encoding.  To represent a
character using quoted-printable encoding, your mailer converts the value of the character
to two hexadecimal digits and preceed them with an equals sign.  So, “é” becomes “=E9”
while your mail is being sent.  Your recipient’s mailer then changes the “=E9” back into
an “é” and:

«Il est démontré, disait-il, que les choses ne peuvent être autrement;

car tout étant fait pour  une fin, tout est nécessairement pour la

meillure fin.»  -- Voltaire, “Candide”
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Quoted-printable encoding is a wonderful thing when it works.  The problem is that not
all mailers are as forward-thinking as Eudora, and they do not all support MIME.  If your
recipient doesn’t have MIME, they may find the presence of quoted-printable encoding to
be more objectionable than the mangling of a few special characters.  They may wish
they could get “André”, but if they can’t, they might rather have “Andri” than
“Andr=E9”.

Also, if quoted-printable encoding is used, it affects more than just international
characters.  Since “=” is used in the encoding, it must be encoded specially, and all the
equals signs in your mail will be turned into “=3D” while your mail is sent.  Moreover,
mail encoded in quoted-printable must have lines no more than 76 characters long; lines
longer than that will be split in two, and an equals sign placed at the end of the first line.
All this damage gets repaired if the recipient has a MIME mailer, but if they don’t, it can
be quite unpleasant.

Disabling Quoted-Printable Encoding
If your recipient doesn’t have a MIME mailer, there are several ways to avoid using
quoted-printable encoding.  These are described below.

Don’t Use International Characters
The simplest way to avoid quoted-printable is to not use any international characters.
Avoid “André”, and Eudora won’t use quoted-printable.  However, there is a catch to
this; when Eudora sends plain text attachments and the Always include Macintosh
information is off, Eudora will always use quoted-printable encoding for the attachment.
This is because Eudora has to decide whether or not to use quoted-printable before it
begins sending the attachment, when it doesn’t yet know if the attachment contains
special characters.  Eudora errs on the side of caution, and always uses quoted-printable
for plain text attachments.

Use Fix Curly Quotes
The Fix Curly Quotes option is a way to avoid using quoted-printable if your mail
contains just a few select special characters; namely the “curly quotes” (“”‘’), bullet (•),
and em and en dashes (– —).  Since these characters often appear in Macintosh
documents, but have very reasonable US-ASCII equivalents, some users choose to have
these characters changed into US-ASCII.  If you turn Fix Curly Quotes on, these
characters will be changed into US-ASCII, and they won’t invoke quoted-printable.

Use the US-ASCII Transliteration Table
Another way to avoid quoted-printable is to install EudoraTables and choose the US-
ASCII transliteration table (see the “Transliteration Tables” section).  This maps all
international characters to their nearest US-ASCII equivalents.  “André” will become
“Andre”; not great, but perhaps better than “Andri” or “Andr=E9”.

Turn Off the QP Icon
The QP icon on the icon bar of a composition window controls whether or not Eudora is
allowed to use the quoted-printable encoding.  If you uncheck the QP icon, Eudora won’t
use quoted-printable for that message, no matter what.

Turn Off the May Use Quoted-Printable Option
The May Use Quoted-Printable switch in the Settings dialog (Sending Mail) controls the
default setting of the QP icon.  If you turn this switch off, messages you create will never
use quoted-printable encoding.
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Transliteration Tables
When Eudora sends mail that includes characters like “é”, it normally “transliterates”
them (Eudora changes the character code from the Macintosh character set to the ISO
Latin-1 character set).  So, “é” gets changed from 142 (the Macintosh character code) to
233 (the ISO Latin-1 character code).  When Eudora receives mail, the reverse is done,
and 233 becomes 142.

This process is controlled by “transliteration tables” (“tables” for short) which are stored
as ‘taBL’ resources.   A table consists of 256 numbers.  Tables are used by using the
character code to be transliterated as an index into the table, and replacing it with the
value found at that position in the table.  For example, when transliterating an “é” from
the Macintosh character set to ISO Latin-1, we look at place 142 in the table (142 is the
Macintosh character code for “é”); there we find a 233 (the ISO Latin-1 character code
for “é”), and so we replace 142 with 233.

Eudora comes with four ‘taBL’ resources.  Their resource id’s and purposes are:

1001 ISO Latin-1 to Macintosh.  This table is used to transliterate from character codes
in ISO Latin-1 to character codes in the Macintosh character set.

1002 Macintosh to ISO Latin-1.  This table is used to transliterate from the Macintosh
character set to the ISO Latin-1 character set.

1003 Identity table.  This table is provided as a reference for people who wish to write
their own tables.

1004 Fix curly quotes table.  This table is used by the Fix Curly Quotes switch, for
people who would rather stick to US-ASCII where possible.

More Tables
If ISO-Latin-1 is not the character set for you, it is possible to get Eudora to offer you
more choices.  Simply drag the “Eudora Tables” document into your Preferences Folder
within your System folder. When you are done, launch Eudora.  The “Priority” menus on
incoming and outgoing mail now have some new choices.  These choices allow you to
control how your mail is transliterated.

           
Priority Menus with Transliteration Tables

Incoming Messages
The table (if any) that is being used to display the current message is checked.  The table
that is used by default (if any) to view messages is outlined.
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To change the table that is used to display a message, select the table you want to use
from the Priority popup menu.  The message is redisplayed using that table, and that table
is used to display the message from then on.

Outgoing Messages
The table (if any) that is used when the current message is sent is checked.  The table that
is used by default (if any) when sending messages is outlined.

To change the table that is used to send the message, simply select the table you want to
use from the Priority popup menu.

Default Tables
If you usually want to view or print your mail with a particular table, hold down the
[shift] key when selecting the table from the Priority popup menu for an incoming
message.  The table title is outlined in the Priority popup menu to show that it is the
default table, and from then on your messages are viewed with that table, unless you
specify otherwise.

Note: If an incoming message uses MIME and Eudora knows the character set
the message uses, the message is transliterated before it is stored, and a
viewing table is not needed or used.

If you usually want to use a particular table for outgoing mail, hold down the [shift] key
when selecting the table from the Priority popup menu for an outgoing message.  The
table title is outlined in the Priority popup menu to show that it is the default table, and
from then on your messages are sent using that table, unless you specify otherwise.

To clear the default table, hold down the [shift] key and select the outlined table from the
appropriate menu.  The default then becomes no table.

No Table At All
If you want a particular message not to be displayed (or sent) with any table, pull down
the Priority popup menu.  The table in effect for that particular message is checked.
Choose the checked item; the check mark is erased and no table is used when that
message is displayed (or sent).

Summaries
For non-MIME mail, the sender and subject lines are run through the default viewing
table when mail arrives, and placed in the message summary (for display in mailbox
windows and in the editable subject area).  Subsequent viewing table changes won’t
affect the summaries.  For incoming MIME mail, no such transliteration is done, because
MIME has a mechanism for specifying character sets in names and subjects.
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Ph and Finger
Ph and finger queries are transliterated according to the tables chosen at the bottom of the
window:

Controlling transliteration in the Ph window

What you type is transliterated with the “Query Table,” and the server’s response is
transliterated with the “Result Table.”

Attachments
Transliteration tables are normally not used when sending or receiving attachments,
unless those attachments are plain text documents.  If the attachments are plain text
documents, they will be transliterated if the “Always As Documents” option is turned off,
or if the “AppleDouble” attachment type is chosen.

Creating New Tables
If you are trying to use a character set that Eudora doesn’t understand, you can build
tables for it.  You will need to create two ‘taBL’ resources, and probably your own
‘euTM’ resource as well.

Choosing Resource Id’s
You need to choose two resource id’s for your tables.  These id’s should be consecutive,
with the lower-numbered id being odd.  The odd-numbered id is used for incoming mail,
and the even-numbered table is used for outgoing mail.  In order to avoid id conflicts,
take the Macintosh country code, multiply by 10, add 2000, and add 1 if the table is for
incoming mail, or 2 if the table is for outgoing mail.  For example, the table that maps
Swedish ASCII to Macintosh characters is:

10*7 (seven is the country code for Sweden) + 2000 + 1 (since the table is used for
receiving mail), or 2071.

Creating the ‘taBL’ Resources
Once you’ve chose id’s, make the ‘taBL’ resources.  ResEdit’s general editor works quite
well for tables.  You will probably wish to copy the ‘taBL’ resource id 1003 to serve as a
starting point.  That way, you only need modify the parts of the Macintosh character set
that need to be transliterated.  The names of the resources will be used in the menus, so
name the table resources descriptively.  It’s also a good idea to create your resources in a
“plug-in” file; a file with type ‘rsrc’ and creator ‘CSOm’.  That way, users can easily
install and remove your table, and your table won’t get wiped out if they upgrade their
copy of Eudora or EudoraTables.
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Creating an euTM
The ‘euTM’ resource is used for naming character sets.  Character sets must be named so
that mailers know which character set is being used.  The official MIME names for
character sets are often very unpleasant.  For example, the name for a common Swedish
character set is “SEN_850200_B.”

Part of an euTM Resource

The ‘euTM’ resource is a list of resource id’s and names.  When Eudora is sending mail,
it will subtract 1 from the table’s resource id, then look for that resource id in all the
‘euTM’ resources it can find.  When it finds a matching id, the name corresponding to the
id is used.

For example, a user choosing the Mac->se table would be using table id 2072.  Eudora
subtracts one, finds 2071 in the second position in the ‘euTM’ resource, and sends the
mail with a character set name of “SEN_850200_B.”

When receiving mail, the process is reversed; the character set name is looked up, the
resource id found, and that transliteration table used for the mail.

For your table, you should create an ‘euTM’ resource, list the resource id of your table
(only the odd id), and the name that should be used in mail for the character set.
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Introduction
Eudora works with UUCP in almost exactly the same way as it works with the POP and
SMTP servers.  Attachments are supported, as is regular mail checking and the other
features.  It is possible to mix methods; for example, you can use UUCP for reading mail
but SMTP for sending it.

Eudora does not come with UUCP.  Three available Macintosh UUCP systems are “uupc
3.0” (dplatt@snulbug.mtview.ca.us), “gnuucp” (jim@fpr.com) and “UUCP/Connect”
(formerly “µAccess,” sales@intercon.com).  “UUCP/Connect” is commercial; the other
two are free ware.  Eudora has been tested with all three packages; it works well with
uupc 3.0 and UUCP/Connect, but it does not work very smoothly with gnuucp.

Settings Dialog for UUCP

Personal Information settings for UUCP

Hosts settings for UUCP

QUALCOMM Incorporated 131



Appendix F – Using UUCP Eudora User Manual

POP Account
If you are going to receive mail via UUCP, you should put the full path name of your
“mail drop” (the file where UUCP leaves mail for you) in the POP Account field.
Precede the name with an exclamation point.

MacTCP/Communications Toolbox
This setting doesn’t matter if you’re doing pure UUCP mail.  If you’re trying to mix
UUCP with SMTP or POP, set this to whatever is appropriate for your SMTP or POP
connection.

SMTP Server
If you want to send mail via UUCP, several items have to go in the SMTP Server field.
Each one should be preceded by an exclamation point.  The items are, in order:

mac - the UUCP name of your Macintosh.

spoolpath: - the full path name of the UUCP working directory.

user - your user name on your mac

0000 - a four-digit sequence number; will be incremented by Eudora.

Return Address
If you use UUCP for reading your mail, you must put your correct return address in the
Return Address field.  It is absolutely vital that this address be correct.  If it’s wrong, no
one is able to reply to your mail and the mail transport system is unable to tell you your
mail can’t be delivered.

Operation
Almost all Eudora features work normally with UUCP.  The one exception is the Leave
Mail On Server (LMOS) option.  When Eudora is used with POP, setting LMOS results
in Eudora downloading only unread mail.  With UUCP, however, Eudora does not
distinguish between read and unread mail; it downloads all the mail at each check.  This
results in duplicate messages, unless you use some other means to clean out your mail
drop between Eudora checks.  It is suggested that the LMOS option remain turned off
when using UUCP.

Internals
Mail Drop Format
Eudora expects the mail drop to be in standard UNIX mailbox format, with UUCP
envelopes (“From ” lines) at the beginning of each message.  The mail drop should use
carriage returns (not line feeds) for new lines.

Working Files
When sending mail, Eudora creates two files in the UUCP work directory.  These files
are:

D.mac0####
The message itself is put in this file.  As distributed, Eudora uses returns for new lines in
this file.  That can be changed by editing the last characters of STR# resource id 8000,
string 5; Eudora will use whatever non-printable characters are at the end of the string.
The mail begins with a UUCP envelope.  The “####” stands for the four-digit sequence
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number mentioned in the “SMTP Server” section above.  It increments as each message
is sent.

X.mac0####
Commands for the UUCP system are put in this file.  These commands are all editable via
ResEdit; they are distributed with returns at the ends.

U user mac
; identifies you (STR# id 8000, string 1)

F D.mac0####
; this file contains your message (8000,2)

I D.mac0####
; use your mail for input (8000,3)

C rmail recipient...
; all recipients of the mail are listed here (8000,4)
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What is MIME?
“MIME” stands for Multipurpose Internet Mail Extensions.  MIME serves two major
purposes – it allows mail applications to tell one another what sort of data is in mail, and
it also provides standard ways for mail applications to encode data so that it can be sent
through the Internet mail system.

MIME Encodings
The Internet uses the “SMTP” protocol to move mail around.  SMTP is limited to the US-
ASCII character set (see Appendix E).  This is a problem for people who speak languages
other than American English and so need accented characters or non-American letters, or
for people who want to use special symbols like section mark (§).

MIME provides a way around this restriction.  It offers two encodings, “quoted-printable”
and “base64.”  These encodings use US-ASCII character codes to represent any sort of
data you like, including special characters or even non-text data.

“Quoted-printable” is used for data that is mostly text, but has special characters or very
long lines.  It’s very simple.  Quoted-printable looks just like regular text, except when a
special character is used.  The special character is replaced with an “=” and two more
characters that represent the character code of the special character.  So, a section mark
(§) in quoted-printable looks like “=A8”.

However, there are some other things that quoted-printable does.  For one, since it uses an
“=” to mean something special, equal signs must themselves be encoded (as “=3D”).
Second, no line in quoted-printable is allowed to be more than 76 characters long.  If your
mail has a line longer than 76 characters, the quoted-printable encoding will break your
line in two and put an “=” at the end of the first line, to signal to the mail reader at the
other end that the two lines are really supposed to be all one line.  Finally, a few mail
systems either add or remove spaces from the ends of lines.  So, in quoted-printable, any
space at the end of a line gets encoded (as “=20”), to protect it from such mail systems.

Let’s try an example.  Here’s a passage of text that you might type on your Macintosh:

«Il est démontré, disait-il, que les choses ne peuvent être autrement; car tout

étant fait pour une fin, tout est nécessairement pour la meillure fin.»

Without any encoding, this might show up on your recipient’s screen as:

+Il est dimontri, disait-il, que les choses ne peuvent btre autrement; car tout

itant fait pour une fin, tout est nicessairement pour la meillure fin.;

This corruption happens because SMTP cannot handle the special characters.  However,
if you and your recipient both have MIME, quoted-printable encoding would be used, and
your text would show up properly:

«Il est démontré, disait-il, que les choses ne peuvent être autrement; car tout

étant fait pour une fin, tout est nécessairement pour la meillure fin.»
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While your mail was actually in transit, however, it would have looked like:

=ABIl est d=E9montr=E9, disait-il, que les choses ne peuvent =EAtre =

autrement; car tout =E9tant fait pour une fin, tout est n=E9cessairement =

pour la meillure fin.=BB

Base64 encoding is another way to protect binary data from the SMTP mail system.
However, Base64 makes no attempt to be legible, and is most appropriate for non-text
data.

MIME Labelling
The other important part of MIME is that it lets mailers communicate what kind of data is
in a message (or part of a message).  The primary mechanism used for this is the Content-
Type header:

Content-Type: text/plain; charset=iso-8859-1

A content-type header is divided into three parts; the content type, the content subtype,
and the parameters.  In this case, the content type is “text,” meaning the message contains
mostly legible text.  The content subtype is “plain,” which means there aren’t any
formatting commands or anything like that embedded in the text.  Finally, “charset=iso-
8859-1” is a parameter; in this case it identifies the character set the message uses.

The major content types are:

text legible text

image pictures and graphics

audio sound

video moving pictures

message messages or pieces of messages

multipart several different kinds of data in a single message

Practical Issues
There are really only two things you sometimes need to do with Eudora and MIME.  One
is that it may occasionally be necessary to turn off quoted-printable encoding.  Another is
that you may want to know how to define mappings between MIME types and Macintosh
types.

Turning Off Quoted-Printable
Eudora automatically uses quoted-printable encoding if your mail contains special
characters.  Eudora also uses quoted-printable encoding for attached plain text files.  If
your recipients don’t have MIME, quoted-printable may hurt more than it helps.  If that’s
the case, just turn off the QP icon when you are sending text files to those recipients.
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Turning Off Quoted-Printable Encoding

Mapping Between MIME Types and Macintosh Types
When you send attached files to other Eudora users, Eudora automatically knows what
kind of data is in the files, because Eudora sends along special information with the file.
However, if you’re sending the file to a non-Macintosh user, or receiving files from a
non-Macintosh user, it’s important to get the right MIME type information on the file, or
for Eudora to understand what the MIME type information means.

Eudora knows about some MIME types.  However, since new MIME types are being
defined all the time, it may be necessary to add to Eudora’s knowledge from time to time.
If you’re familiar with ResEdit, this isn’t too hard to do.

The way Eudora maps between MIME and Macintosh types is with EuIM and EuOM
resources.  EuOM resources are used for sending attachments, EuIM for receiving.  They
have the same basic structure.

EuOM and EuIM resources are lists of individual elements called “maps.”  Each map
describes a Macintosh document type (or MIME data type) and then lists what MIME
data type (or Macintosh document type) it corresponds to.  For any given type, Eudora
looks through all the maps in all the EuOM or EuIM resources, and uses the best match.

Note: EuOM and EuIM resources are also used when uuencoding and
uudecoding files, so that filename suffixes can be mapped to and from
Macintosh types.  A good set of EuIM and EuOM resources can
substantially improve document exchange with systems that use uuencode.

Sending
When you create a map in an EuOM resource, you use the “Creator Code” and “Type”
fields to specify what documents the map applies to.  These fields should be filled with
the four-byte creator code or Macintosh type of the documents you want to send.  If you
leave the Creator Code blank, but fill in the type, the map is used for any document of
that type, regardless of creator.  If you fill in both Creator Code and Type, a document
has to match both for the map to be used.  Given the choice, Eudora uses the map that
matches both creator and type.

The other parts of the map are used to construct the MIME information.  Content Type
and Content Subtype are the MIME type and subtype to use for the document.  Filename
suffix allows you to tell Eudora to add a suffix to the filename, as an extra hint to the
receiving system (for example, you might have Eudora add “.xls” to Excel files).

“Newline conversion?” tells Eudora whether or not to convert carriage returns in the file
to carriage return, linefeed.  Usually, you should set this to 1 for text data, but to 0 for
binary files.

Finally, “May suppress resource fork?” is used in conjunction with Eudora’s Always
include Macintosh information.  If you set this to 1, and Always As Documents is off,
Eudora won’t send Macintosh type and creator information with the file, and won’t send
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the resource fork.  Instead, it will just send the data fork with the MIME information
attached to it.

An Example Map in an EuOM Resource

The map above says that all files of type “EPSF,” no matter what the creator, should be
sent as “application/postscript,” that “.eps” should be added to the filename, that carriage
returns should not be turned into carriage return/linefeed pairs, and that when the Always
include Macintosh information is off, the resource fork won’t be sent.

Receiving
EuIM resources are used for receiving files.  They’re pretty much the same as EuOM
resources, except that the MIME type and subtype are used for matching, and the
Macintosh creator code and type are applied to the file received.

As with EuOM resources, you can leave parts blank.  If you want to match all files with
an “.eps” suffix, regardless of the MIME type or subtype, leave the type and subtype
blank.  If you don’t care what the filename suffix is, leave that blank and match with the
MIME type and/or subtype only.  Again, as with EuOM resources, Eudora will choose
the map that matches best.

With EuIM resources, it’s sometimes a good idea to use several maps to catch all
important cases.  For example, it might be a good idea to have three maps for dealing
with PostScript files, as follows:

Content Type: application
Content Subtype: postscript
Filename suffix:
Creator Code: mlpr
Type: TEXT

This map will catch most MIME PostScript files, and set their creator to MacLPR.

Content Type:
Content Subtype:
Filename suffix: .eps
Creator Code: dPro
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Type: EPSF

This map will match any incoming file with a suffix of “.eps,” regardless of the MIME
type info, and set it’s type to “EPSF” and creator to “dPro” (MacDraw Pro).  But what if
a file comes in with a suffix of “.eps” and a MIME type/subtype of
“application/postscript”?  Which map gets used?  The first one gets used; when Eudora
has a choice between matching a suffix and matching MIME type information, MIME
wins.  A third map may be in order:

Content Type: application
Content Subtype: postscript
Filename suffix: .eps
Creator Code: dPro
Type: EPSF

This makes application/postscript files with suffixes of “.eps” get type EPSF and creator
dPro.
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